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About Custom Sound® Pro software 
Custom Sound® Pro software is intended to be used by cochlear implant and hearing care 
professionals to create and modify hearing profiles in order to provide comfortable and 
usable stimulation to cochlear implant patients. (The hearing profile refers to the recipient 
MAP as well as other device configuration completed in Custom Sound as described in this 
guide.) 

• Login 

• Patient List 

• Dashboard 

• Measure 

• Adjust 

• Finalise 

• My clinic 

• Reference topics 
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Intended purpose 
The fitting software is used in combination with other devices as part of a hearing implant 
system. It is intended to create and modify hearing profiles, to monitor the performance of 
the system and to facilitate firmware updates of the system. 

Indications 
These sections contain the indication for use for the core Custom Sound Pro software and 
specific indication for features within the software. 

Custom Sound Pro software 
Custom Sound Pro software operates in conjunction with a compatible Cochlear™ sound 
processor. It is compatible with all Cochlear Nucleus® implants and auditory brainstem 
implants: 

• CI600 Series Implants: CI612, CI622, CI624, CI632 

• CI500 Series Implants: CI512, CI513, CI522, CI532, CI551, ABI541 

• CI24RE Series Implants: CI422, CI24REH (Hybrid L24), CI24RE (CA), CI24RE (ST), CI24RE 
(CS), CI24RES, Hybrid S12, Hybrid S8 

• CI24R Series Implants: CI24R (CA), CI24R (CS), CI24R (ST) 

• CI24M Series Implants: CI24M, ABI24M, CI11+11+2M, CI24MH (CI+6+2M) 

• CI22M Series Implants: CI22M, CI1+10+11, ABI22M 

Custom Sound Pro software is indicated for use with recipients of a Cochlear Nucleus 
Implant who have any of the following Cochlear Sound Processors: 

• Nucleus 8: CP1110 

• Kanso® 2: CP1150 

• Nucleus 7: CP1000, Nucleus 7 SE: CP1001 and Nucleus 7 S: CP1002 

• Kanso: CP950 

• Nucleus 6: CP910, CP920 

• Nucleus 5: CP810 

• CP802 

• Freedom: Freedom® Sound Processor, Freedom Hybrid™ Sound Processor 
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Remote Assist 
Remote Assist feature delivers the ability to conduct a remote session via a live video 
through the Custom Sound Pro software and the Nucleus Smart App. It enables the 
clinician to make select programming adjustments, enable processor settings and provide 
counselling via a live video session with their patient. 

• The in-app video functionality, chat functionality and enabling patient control of 
processor settings (ForwardFocus, Volume and Sensitivity), are indicated for use for 
the recipients of a Cochlear Nucleus implant with the compatible sound processors 
shown in the table below.  

• The remote global adjustment and enabling patient control of processor settings 
(MVBT- Master Volume, Bass, Treble) are indicated for use for recipients with the 
compatible sound processors and a compatible Cochlear Nucleus implant shown in 
the table below.  

Remote Assist Functions Sound Processors Implants 

• Video  

• Chat 

• Enabling patient control of 
processor settings  
(ForwardFocus 2, Volume and 
Sensitivity) 

• Nucleus 8 

• Nucleus 7 

• Nucleus 7 SE 

• Nucleus 7 S1 

• Kanso 2 

• Sound processors in Hybrid 
configuration 

Implant compatibility is not 
relevant for this function 

As above plus: 

• Remote global adjustment 

• Enabling patient control of 
processor settings (MVBT) 

• Nucleus 8 

• Nucleus 7 

• Nucleus 7 SE 

• Nucleus 7 S1  

• Kanso 2 

• CI600 Series: CI612, CI622, 
CI624 and CI632 

• CI500 Series: CI512, CI522 
and CI532 

• CI24RE Series: CI24RE (CA), 
CI24RE (ST) and CI422 

1: Compatible only with Nucleus Smart App (Model No: NSA-2) for Android 
2: ForwardFocus is compatible with Nucleus 8, Nucleus 7 and Kanso 2 Sound Processors 
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Contraindications 
These sections contain the contraindication for the core Custom Sound Pro software and 
specific contraindication for features within the software. 

Custom Sound Pro software 
Custom Sound Pro software is not indicated for use with sound processors other than 
those listed in Indications. 

Remote Assist 
In-App Video and Chat, Enable ForwardFocus (FF) 

Remote Assist in-app video, chat and enabling patient control of processor settings 
(ForwardFocus only) are not indicated for use with sound processors other than those 
listed in Indications. 

Remote Global Adjustment, Enable Patient Driven Master Volume Bass Treble (MVBT) 

Remote Assist remote global adjustment and enabling patient control of processor 
settings (MVBT) are not indicated for use for recipients with sound processors and 
implants other than those listed in Indications. 

Intended patient population 
Custom Sound Pro software is intended for patients implanted with a compatible 
Cochlear™ Nucleus® implant and with a compatible Cochlear sound processor. There are 
no restrictions for the intended patient population of Custom Sound Pro software in terms 
of age, weight, health or other condition. 

Clinical benefit 
Custom Sound Pro software operates in conjunction with a compatible Cochlear™ 
Nucleus® implant system. Potential benefits of receiving a Cochlear™ Nucleus® implant 
system Include: 

• Better understanding of speech in quiet 

• Better understanding of speech in noise 

• Increased satisfaction based on hearing capabilities 
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Intended users 
The intended user group(s) for Custom Sound Pro software are: 

•  Audiologist/ clinician. 

Special training or qualifications 
Clinicians using the Custom Sound Pro software must have training in audiology, including 
an understanding of audiological software functionality, basic understanding of 
information technology and experience with programming cochlear implant systems. 

Use environment 
The use environment for Custom Sound Pro software is a non-sterile environment with 
programming software operating on either a desktop computer, laptop or tablet. This may 
occur in a clinician’s office (audiological clinic), or in another environment where the user 
and patient are able to focus on the software tasks without distraction and speak to and 
hear one another clearly (e.g. quiet, enclosed room with minimal ambient noise in the 
home healthcare environment).  

A clinician may also intentionally select a noisier environment to ascertain the effectiveness 
of a MAP in different conditions. 
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Cochlear implant compatibility with Custom Sound Pro 
software 
Cochlear™ implant system component combinations compatible with Custom Sound Pro 
software are listed below:  

Cochlear Nucleus® Implants     Cochlear Nucleus® Sound Processors 

        

Nucleus® CI632 cochlear implant       

Nucleus® CI624 cochlear implant       

Nucleus® CI622 cochlear implant       

Nucleus® CI612 cochlear implant       

Nucleus® CI551 cochlear implant       

Nucleus® CI532 cochlear implant       

Nucleus® CI522 cochlear implant       

Nucleus® CI513 cochlear implant       

Nucleus® CI512 cochlear implant       

Nucleus® ABI541 auditory brainstem 
implant 

      

Nucleus® CI422 cochlear implant       

Nucleus® Hybrid™ L24 cochlear implant       



  

14 – Custom Sound Pro software User Guide © Cochlear Limited 2024 

Cochlear Nucleus® Implants     Cochlear Nucleus® Sound Processors 

        

Nucleus® Freedom® CI24RE (CA) Contour 
Advance® cochlear implant 

      

Nucleus® Freedom® CI24RE (ST) Straight 
cochlear implant 

      

Nucleus® Freedom® CI24RE (CS) 
Contour® cochlear implant 

      

Nucleus® 24 Contour Advance® CI24R 
(CA) cochlear implant 

      

Nucleus® 24k CI24R (ST) cochlear implant       

Nucleus® 24 Contour® CI24R (CS) 
cochlear implant 

      

Nucleus® 24 ABI Auditory Brainstem 
Implant 

      

Nucleus® 24 Double Array implant       

Nucleus® 24 CI24M cochlear implant       

Nucleus® 22 cochlear implant      
 *  

 
* 

 
* 

  

  
Available 

* Requires Nucleus 22 coil 
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Cochlear Nucleus® Implants     Cochlear Nucleus® Sound Processors 

            

Nucleus® CI632 cochlear implant             

Nucleus® CI624 cochlear implant             

Nucleus® CI622 cochlear implant             

Nucleus® CI612 cochlear implant             

Nucleus® CI551 cochlear implant        

Nucleus® CI532 cochlear implant       

Nucleus® CI522 cochlear implant       

Nucleus® CI513 cochlear implant       

Nucleus® CI512 cochlear implant       

Nucleus® ABI541 auditory brainstem 
implant 

        

Nucleus® CI422 cochlear implant       

Nucleus® Hybrid™ L24 cochlear implant        
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Cochlear Nucleus® Implants     Cochlear Nucleus® Sound Processors 

            

Nucleus® Freedom® CI24RE (CA) Contour 
Advance® cochlear implant 

      

Nucleus® Freedom® CI24RE (ST) Straight 
cochlear implant 

      

Nucleus® Freedom® CI24RE (CS) 
Contour® cochlear implant 

      

Nucleus® 24 Contour Advance® CI24R 
(CA) cochlear implant 

      

Nucleus® 24k CI24R (ST) cochlear implant       

Nucleus® 24 Contour® CI24R (CS) 
cochlear implant 

      

Nucleus® 24 ABI Auditory Brainstem 
Implant 

         

Nucleus® 24 Double Array implant        

Nucleus® 24 CI24M cochlear implant       

Nucleus® 22 cochlear implant  
* 

 
* 

       
* 

Available 

* Requires Nucleus 22 coil 

 Note: 

• CP1150 - Kanso 2 and CP950 - Kanso Sound Processors do not support acoustic 
hearing. 

• Not all products are approved in all markets. 

• Some products may no longer be approved. 

• Some products require a regional option to be installed. See your Cochlear 
representative for information about regional options. 
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Remote Assistant compatibility with Custom Sound Pro 
software 
The software on the following remote assistants are compatible with these sound 
processors and can be upgraded with Custom Sound Pro software: 

Cochlear Nucleus® Remote Assistants     Cochlear Nucleus® Sound Processors 
  

      

Nucleus® CR110 Remote Assistant             

Nucleus® CR210 Remote Control            
* 

Nucleus® CR220 Intraoperative Remote 
Assistant 

            

Nucleus® CR230 Remote Assistant            

Nucleus® CR310 Remote Control  
* 

 
* 

 
* 

 
* 

 
* 

  

Nucleus® Smart App  
* 

 
* 

 
* 

 
* 

 
* 

  

Available 

* The Nucleus Smart App, the CR310 and CR210 Remote Control software cannot be upgraded with Custom 
Sound Pro software 
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Cochlear Nucleus® Remote Assistants     Cochlear Nucleus® Sound Processors 
  

      

Nucleus® CR110 Remote Assistant            

Nucleus® CR210 Remote Control  
* 

 
* 

        

Nucleus® CR220 Intraoperative Remote 
Assistant 

           

Nucleus® CR230 Remote Assistant         

Nucleus® CR310 Remote Control             

Nucleus® Smart App             

Available 

* The Nucleus Smart App, the CR310 and CR210 Remote Control software cannot be upgraded with Custom 
Sound Pro software 

  

 Note: 

• CP1150 - Kanso 2 and CP950 - Kanso Sound Processors do not support acoustic 
hearing. 

• Not all products are approved in all markets. 

• Some products may no longer be approved. 

• Some products require a regional option to be installed. See your Cochlear 
representative for information about regional options. 
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System requirements 
  Minimum system 

requirements 
Recommended system 
requirements 

Operating system Windows® 10 (64‐bit) Version 
2004 or Windows 11 21H2 

(Note: 32‐bit versions of 
Windows 10 are not 
supported)  

Windows 10 (64‐bit) Version 
22H2 or Windows 11 22H2 or 
later 

(Note: 32‐bit versions of 
Windows 10 are not supported)  

Processor 6th Generation Intel® Core™ 
i5 Processor i5 6400/AMD 
Ryzen 5 2600 

9th Intel Core i5 9500 
Processor/ AMD Ryzen 5 3600 
or faster 

RAM 8 GB of DDR3 or higher 12 GB DDR4 RAM 

Hard drive Solid State hard drive with 10 
GB of available space 

HDD 10 GB Free Solid State 
NVMe PCIe 

Screen resolution 1920 x 1080 1920 x 1080 

Screen size (for tablet use) 12 inches or higher 12 inches or higher 

USB port 2 x USB A ports 2 x USB A ports 

Wireless Bluetooth® 4.0 required for 
Cochlear™ Wireless 
Programming Pod 

Bluetooth 4.0, or higher, 
required for Cochlear Wireless 
Programming Pod 

SQL Server® SQL Server 2014  SQL Server 2019 

Microsoft SQL Server Compact 
4.0 x 64 ENU  

or 

Microsoft SQL Server Compact 
4.0 x 86 ENU  

Microsoft SQL Server Compact 
4.0 x 64 ENU  

or 

Microsoft SQL Server Compact 
4.0 x 86 ENU  
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To participate in Remote Assist sessions the computer system running the Custom Sound 
Pro software will also need the following: 

Video Integrated laptop camera or USB 2.0 video camera 

Voice Compatible microphone and speakers, headset with 
microphone, or equivalent device 

Network A stable internet connection 

  

It is important to keep the Windows® operating system up to date. The computer or tablet 
must be capable of receiving Windows updates. 

  

Any computer system connected to the Cochlear™ system, when used in programming 
mode, should meet FCC 47CFR Part 15 Class B and CISPR22 Class B emissions 
requirements. Consult the documentation provided by the computer system manufacturer 
to ensure compliance, prior to connecting any Cochlear device. 

Installation and upgrade for Custom Sound Pro software 
Please refer to the Custom Sound Pro software- Installation Guide for full installation 
instructions. 

When installing or upgrading Custom Sound Pro software , the computer may need to be 
restarted. Ensure you close any applications before installing the software. 

When installing Custom Sound Pro software, the user account used for installation must be 
added to the Windows Administrator group. When creating a database connection using 
the Windows integrated security option, use the CochlearClinical user account so that 
clinicians can start Custom Sound Pro software without experiencing any errors related to 
connecting to the database. 

Upgrading to Custom Sound Pro software from earlier versions may require a database 
upgrade. If your clinic uses a network database, careful planning is required to ensure that 
all computers with Custom Sound Pro software can connect to the database. 
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Security considerations 
Medical device security is a shared responsibility between medical device manufacturers 
and health care facilities. Custom Sound Pro software includes a number of built-in 
features that can help protect the integrity of information such as: 

• Removal of patient-identifiable details from records when anonymously exported 
from the Cochlear database 

• Validation checks within the Cochlear database to maintain data integrity 

• A backup utility for the Cochlear database 

• Encryption of CDX files that are exported from Custom Sound Pro software 

• Code signing of installer executables 

• User names and passwords to control access to Custom Sound Pro software 

To help reduce the risk of unauthorised access to Custom Sound Pro software it is best 
practice to implement an IT security policy within the healthcare facility that considers the 
following items: 

• Windows operating systems including the latest security updates from Microsoft® 

• Anti-virus software including the latest updates available from the vendor with 
regular scanning of hard disk 

• Scanning of USB storage devices for malware or viruses before connecting to the 
computer running Custom Sound Pro software 

• Firewalls to protect computers running Custom Sound Pro software that are 
accessible to the Internet 

• A password policy that requires strong passwords that are changed regularly and are 
applied to user accounts on computers where Custom Sound Pro software is 
installed and network-connected computers where the Cochlear database is installed 

• Locking computers when unattended 

• Regular backups of the Cochlear database 

Cochlear also suggests following the recommendations from the Security practices 
section of the Custom Sound Pro software- Installation Guide. 
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Login 
When you start Custom Sound Pro software the Login window opens. Use the Login 
window to log in to Custom Sound Pro software. 

 Note: Login is not required when the Cochlear Account Administration Tool (CAAT) has 
been set up. For more information see the section Cochlear Account Administration Tool 
(CAAT). 

  

Display the Hardware Options window to set the Ports, Protocols, and Application Services 
(PPS) values for the Custom Sound Pro software communication port. 

Task steps: 

1. Double-click the Custom Sound Pro software icon located on the desktop, or from 
the Start menu, under Cochlear. 

2. Select your clinician name from the Clinician drop-down list. 

3. Type your password in the Password box. 

 Note: A password is only required if one has been set up in the Clinician Details 
and Preferences window. 

4. Click Login. 

The Patients screen displays. 

Result: 

• The Custom Sound Pro software application is active with the user logged on. 

Cochlear Account Administration Tool (CAAT) 
The Cochlear Account Administration Tool (CAAT) is an optional user authentication system 
based on Microsoft® Active Directory®. Clinician accounts can be set up for Custom Sound 
Pro software and any other tool that uses Custom Sound Pro software authentication. 
When configured, the clinician will not be required to log in to Custom Sound Pro software. 

 Note: You must install a regional key to access CAAT. 
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Hardware Options 
Sets the Ports, Protocols, and Application Services (PPS) values for the Custom Sound Pro 
software communication port. 

Training mode 
Training mode simulates a connection to a sound processor and allows you to learn the 
features of Custom Sound Pro software without requiring physical hardware. Training 
mode uses a separate database to prevent real patient data from being unintentionally 
edited. 

Training mode includes a test patient. You can add new patients to the training mode 
database. 

Task steps: 

1. Double-click the Training Custom Sound Pro software icon located on the desktop, or 
from the Start menu, under Cochlear. 

2. Set the sound processors you want to use in training mode. 

3. Click Start Training Mode. 

The Patient List screen displays. 

Result: 

 Custom Sound Pro software is open in training mode, indicated by the training mode icon 
. 
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Patient List 
The Patient List screen displays automatically when you log in to Custom Sound Pro 
software, showing a list of all non-archived patients contained in the Custom Sound Pro 
software database. 

Sort the list of patients into ascending or descending order by clicking the column heading 
you want to sort by. Filter the list by typing text into the Search box. You can search using 
patient information such as given name, family name and date of birth. 

You can specify the information shown in the Patient List screen using the Patient List tab 
of the Clinician Details and Preferences window. 

Create a patient 
To program a patient's sound processor, perform intraoperative testing or create a patient 
record in Custom Sound Pro software. 

Task steps: 

1. Click Add in the Patients screen. 

The Patient Details window displays with the General tab selected. 

2. Type the patient's name in the Given Name and Family Name boxes, and select a 
date in the Date of Birth box. 

 Note: You must enter the given name, family name, and date of birth of the 
patient before you can proceed. 

3. Click Next.  

The Hardware tab displays. 

4. Use the drop-down lists under What's on the right side? or What's on the left 
side? and select the corresponding device type. 

 Note: You must select an option for both sides before you can proceed. 

a. For a cochlear implant, choose the correct model, enter other details as 
appropriate, and click Save. 

 Note: Ensure the correct implant is selected. Incorrect implant selection 
may result in excessive or unsafe charge being delivered to the patient. 

 Note: For an activation session, hardware details are able to be added later 
in the programming session. 

b. For a hearing aid, choose the hearing aid model from the Hearing aid type list. 

c. If one side is unaided, select Unaided (PTA ≤ 30dB) SSD for single-sided 
deafness, or Unaided (PTA > 30dB). 

5. Click Next. 
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6. The Audiogram tab appears, displaying right and left audiograms. 

7. Click AC  to select air conduction thresholds, BC  to 

select bone conduction thresholds or Aided  to select aided 
thresholds. 

8. Click the audiogram to enter the thresholds. 

Use the right-click menu to mark a point as no response. 

9. Click Next. 

10. The Contact tab displays. 

11. Enter the patient's Email address, Mobile and/or Telephone number, and address 
information if available. 

12. Click Save to save the changes and close the Patient Details window. 

Result: 

• The Dashboard screen displays, commencing a fitting session for the newly created 
patient. 

 Note: For Freedom Hybrid sound processors, CP900 Series, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7 and CP1110 - Nucleus 8 Sound Processors in 
Hybrid mode, the audiogram must be entered in the Audiogram tab to enable acoustic 
levels to be prescribed. 
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Edit a patient 
Existing patients can be edited as required. 

Task steps: 

1. Click on a patient in the Patients screen and click Edit. 

The Patient Details window displays with the General tab selected.  

2. Update the General tab controls as required. 

3. Click Save to save your changes and close the Patient Details window, 

or: 

select the Hardware tab to update the patient's devices: 

4. To remove a previously specified Cochlear Implant entry: 

a. Click the implant name. 

The Implants window displays. 

b. Change the Status from 'Implanted' to 'Explanted'. 

c. Click Save. 

The Hardware tab displays again showing the status of the side that previously 
had the implant as 'Not Specified'. 

 Note: When the Implants window is displays in future for this side and 
patient, the details of the explanted implant are included. 

5. To add a device: 

a. Use the drop-down lists under What's on the right side? or What's on the 
left side? and select the corresponding device type. 

 Note: You must select an option for both sides before you can proceed. 

b. For a cochlear implant, choose the correct model, enter other details as 
appropriate, and click Save. 

 Note: Ensure the correct implant is selected. Incorrect implant selection 
may result in excessive or unsafe charge being delivered to the patient. 

c. For a hearing aid, choose the hearing aid model from the Hearing aid type list. 

d. If one side is unaided, select Unaided (PTA ≤ 30dB) SSD for single-sided 
deafness, or Unaided (PTA > 30dB). 
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6. Click Save to save your changes and close the Patient Details window, 

or: 

select the Audiogram tab to update the patient's right and left audiograms: 

a. Click AC  to select air conduction thresholds, BC  

to select bone conduction thresholds or Aided  to select 
aided thresholds.  

b. Click the audiogram to enter the thresholds. 

Use the right-click menu to mark a point as no response. 

7. Click Save to save your changes and close the Patient Details window, 

or: 

select the Contact tab to update the patient details. 

8. Change the patient's Email address, Mobile and/or Telephone number, and address 
information as required. 

9. Click Save to save your changes and close the Patient Details window. 

Result: 

• The patient's audiogram data is now available in Custom Sound Pro software and will 
be used to calculate the amount of amplification. 
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Create audiogram 
You can manually create an audiogram in Custom Sound Pro software from pure tone 
audiometric data and /or bone conduction data that will then be available during patient 
sessions. 

 Note: For Freedom Hybrid sound processors, CP900 Series, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, and CP1110 - Nucleus 8 Sound Processors in 
Hybrid mode, the audiogram must be entered in the Audiogram tab to enable acoustic 
levels to be prescribed. 

Task steps: 

1. Select a patient in the Patients List screen and click Edit. 

The Patient Details window displays with the General tab selected. 

2. Select the Audiogram tab. 

The Audiogram tab appears, displaying right and left audiograms. 

3. Click AC  to select air conduction thresholds, BC  to 

select bone conduction thresholds or Aided  to select aided 
thresholds. 

4. Click the audiogram to enter the thresholds. 

Use the right-click menu to mark a point as no response. 

5. Click Save to save the audiogram entries and close the Patient Details window. 

Result: 

• The patient's audiogram data is now available in Custom Sound Pro software. 
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Work with Implant ID 
The Implant ID feature in the CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid 
and Freedom sound processors allows the sound processor to be associated with a specific 
implant or implant type. This reduces the risk of unintended stimulation due to mixing up 
sound processors between patients or between ears. Implant ID is not available for other 
sound processors. 

Once you write a program to the sound processor, the status bar displays the padlock icon, 
indicating that Custom Sound Pro software has programmed the sound processor with 
Implant ID. Implant ID is not activated in the sound processor until a program is written. 

The padlock icons are colour-coded to indicate the level of protection: 

•  Gold: the sound processor that is programmed for use with this specific implant 
will not stimulate another implant. Gold padlock protection is not available for 
Nucleus 24, Nucleus 22 or Freedom (CI24RE) implant types prior to serial number 
1020050437005. 

•  Green: a sound processor that is programmed for use with a specific type of 
implant will not stimulate another implant which is a different type. 

•  Grey: Implant ID has been disabled by a clinician. 

• No icon: Implant ID is not available. 

Where Implant ID is disabled or not available, a sound processor that is placed on the 
wrong implant could result in unintended stimulation. 
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If you experience problems with Implant ID, the auto correct option allows you to clear any 
previously recorded ID value and re-read the ID of that implant (excluding Nucleus 24 and 
Nucleus 22 implant types). Should the problem persist, Implant ID can be disabled for all 
implant types excluding Nucleus 22 implants. 

Task steps: 

1. Ensure the coil is on the patient's implant. 

2. Click the Hardware tab in the Patient Details screen. 

The Hardware tab displays showing the patient implant. 

3. Click Implants. 

The Implants window displays showing the Model, Status, Implant Date and Initial 
Stimulation for the implant. 

4. Click Options. 

The Implant ID Options window displays 

5. Click Auto Correct or Disable Implant ID as required. 

6. Click OK to apply the selected option and close the Implant ID Options window. 

The Implants window displays. 

7. Click Save to save the changed Implant ID status. 

Result: 

• The Implant ID has been corrected or disabled. 

 Note: To re-enable Implant ID, ensure the coil is on the patient's implant, open 
the Implant ID Options window and click Enable Implant ID, then apply and save the 
change. 
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Patient Details 
Specifies information including: 

• Patient identification (Name, Date of Birth, Gender, Cochlear ID, National ID, and 
Clinic's Patient Reference ID). A patient can be created with identification of just 
Name and Date of Birth. 

• The model of implant the patient has been fitted with and the side on which the 
implant has been fitted. 

You can also specify other hearing devices such as bone conduction implants and 
hearing aids. 

• Audiograms for right and left ears. To set acoustic parameters for a patient, you 
must enter the patient's audiogram. 

• Patient contact information (Email, Mobile, Telephone, Street, City/Suburb, 
State/Province, ZIP/Postcode, and Country). 

• Surgical data imported into Custom Sound Pro software. This can include the results 
of a placement check, estimated skin flap thickness, insertion time, angular depth, 
cochlea opening and any surgeon's notes. 

Export a patient 
A patient’s details can be exported to a file, which can then be imported into another 
Custom Sound Pro software database. The Anonymous Export function removes the 
patient's personal details from the exported file. 

Task steps: 

1. Click the desired patient in the Patient list. 

2. Click the Patient menu and select Export or Export Anonymously. 

The Save As window displays. 

3. Navigate to the desired file location. 

4. Enter an appropriate file name or leave the default file name in place. 

5. Click Save. 

Result: 

• The patient details are saved to the specified location as a Cochlear Data Exchange 
File (.cdx*). 
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Import a patient 
Patient files that have been exported from another Custom Sound Pro software database 
can be imported into the patient list. 

Task steps: 

1. Click the Patient menu and select Import patients. 

The Open window displays. 

2. Navigate to the Cochlear Data Exchange File (.cdx*) you want to import and click on 
it. 

3. Click Open. 

Result: 

• The file is imported into Custom Sound Pro software. A new patient is created, or, if 
the patient already exists, the current details are overwritten. 

Manage Patients 
Archived patient records which are not to be used, and restores previously archived 
patient records so they can be used again. 

Archive a patient 
Patients who are no longer active can be archived from the Patient list provided a session 
is not open. 

 Note: An archived patient is not deleted from the database, and can be restored at a 
later date if required. 

Task steps: 

1. Click on Patient > Manage in the Menu bar. 

The Manage Patients screen appears. 

2. Click on the patient to be archived in the Active list. 

3. Click the Archive button on the right hand side of the screen. 

Result: 

• The patient record moves from the Active list to the Archived list and can no longer 
be selected in Custom Sound Pro software. 
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Restore a patient 
You can restore patient data that was previously archived. 

Task steps: 

1. Click on Patient > Manage in the Menu bar. 

The Manage Patients window displays. 

2. Sort patients by clicking the header of the column you want to sort by, or filter the list 
using the Search box. 

3. Click the patient you want to restore in the Archived list. 

4. Click Restore. 

5. Click the Close button  to close the Manage Patients window. 

Result: 

• The patient moves from the Archived list to the Active list, and displays on the Patient 
list screen. 
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Dashboard 
Use the Dashboard screen for an at-a-glance overview of patient information. This includes 
name, age, gender, audiograms, usage data including time on air, session history records, 
and notes taken during the previous session. The dashboard also shows notification that 
new technology is available if the patient's sound processor is more than 5 years old. The 
screen also provides visual cues indicating whether a processor is connected and when the 
patient goes on or off air. 

You can open the Audiogram tab from the Dashboard in add / edit mode when the patient 
is Off Air. This allows you to create or modify multiple audiograms, and update a Hybrid 
prescription based on a new or modified audiogram. 

In most cases, impedance measurement automatically runs on supported implants to turn 
off faulty electrodes and display electrode status. Click the Impedances electrode indicator 

 to display the Impedance Measurement Details window. 

If the patient already has an active MAP, then Custom Sound Pro software automatically 
goes live on that MAP in the dashboard. 

Connect a sound processor 
You can connect a sound processor to a computer via the appropriate programming 
interface: 

• Wireless Programming Pod: for use with CP900 Series and CP800 Series Sound 
Processors, CP1000 - Nucleus 7, CP1001 - Nucleus 7 SE, CP1002 - Nucleus 7 S, CP1150 - 
Kanso 2 and CP1110 - Nucleus 8 Sound Processors, provides wireless connectivity 
between a sound processor and a computer running Custom Sound Pro software, 
using Bluetooth® technology. For instructions on connecting and using the Wireless 
Programming Pod, see the Cochlear Wireless Programming Pod User Guide. 

 Note: There are two models of Wireless Programming Pod, one for CP800 Series 
and CP900 Series Sound Processors and one for CP1000 - Nucleus 7, CP1001 - 
Nucleus 7 SE, CP1002 - Nucleus 7 S, CP1150 - Kanso 2 and CP1110 - Nucleus 8 Sound 
Processors. The Wireless Programming Pod for CP1000 - Nucleus 7, CP1001 - Nucleus 
7 SE, CP1002 - Nucleus 7 S, CP1150 - Kanso 2 and CP1110 - Nucleus 8 Sound 
Processors has the number "7" engraved under the LED. 

• Programming Pod: for use with CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - 
Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, CP900 Series, CP800 Series, 
Freedom Hybrid, and Freedom Sound Processors, provides USB connectivity and 
physically connects a sound processor and computer via a USB cable. 
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Task steps: 

To connect a sound processor:  

1. Connect the Wireless Programming Pod or Programming Pod to the computer on 
which Custom Sound Pro software is running.  

The Wireless Programming Pod must be paired to the computer running Custom 
Sound Pro software before it can be used to program a sound processor. For 
instructions on connecting and using the Wireless Programming Pod, see the 
Cochlear Wireless Programming Pod User Guide. 

The Programming Pod must be connected to a powered USB port and not a USB port 
on the monitor or keyboard.  

 Note: The CP950 - Kanso Sound Processor must have batteries inserted before it 
is connected to a computer for programming. 

2. Connect the sound processor to the programming interface. 

 Note: Ensure you have the correct sound processor for the patient. 

3. If Custom Sound Pro software does not automatically detect the sound processor, 
click the Processor menu and select Connect. 

4. If the firmware of the connected sound processor is not supported by the current 
version of Custom Sound Pro software, the firmware is automatically updated. If any 
existing programs in the sound processor are incompatible with the updated 
firmware, the Update Processor prompt displays: 

• Click Erase Programs and Update to erase the unsupported programs and 
update the firmware. 

• Click Disconnect to disconnect the sound processor from Custom Sound Pro 
software without updating the firmware. 

Result: 

• The status bar indicates the sound processor is connected, and displays any 
programs that have been written to the programming slots. 

 Note: To disable communication between Custom Sound Pro software and an 
attached sound processor, click the Tools menu and select Disable Pod 
Communication. 
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Reset a sound processor 
You can reset a sound processor and clear all current programs from the programming 
slots. 

 Note: The sound processor must be off air to be reset. 

Task steps: 

1. Right-click on the Sound Processor icon (  or ) on the status bar and select 
Reset. 

A confirmation message appears. 

2. Click Yes to confirm. 

Result: 

• The sound processor settings are removed. 

Select a sound processor 
You can select a processor to associate with a cochlear implant on the Dashboard screen. 
Custom Sound Pro software automatically runs impedance measurement on supported 
implants when the processor is selected and displays the result. 

Task steps: 

1. Select a processor from the drop-down list below the named cochlear implant. 

If prompted, confirm that the coil is placed on the correct implant side. 

2. Click Yes if the nominated side is correct. 

In most cases, Impedance runs automatically for the selected implant. 

Result: 

• The impedance measurement result displays as a line of dots representing tested 
electrodes: 

functional electrodes display in green, while turned off 
electrodes display in red. 
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Remote Assist 
Remote Assist delivers the ability to facilitate a remote session with patients via a live video 
session. It gives you the ability to make selected programming adjustments, enable 
processor settings and provide counselling to patients through the Custom Sound Pro 
software and the Nucleus Smart App without the need for patients to attend an in-clinic 
appointment, or having to receive equipment from the clinic for a remote programming 
session. 

Remote Assist allows you to: 

• Establish a live video session with a patient from within the Custom Sound Pro 
software 

• For compatible implants, make global adjustments to the patient's MAP.  
For more information on compatible implants please see the Remote Assist section in 
Indications. 

• Enable patient driven Master Volume, Bass, Treble and ForwardFocus settings 

Remote Assist requires a regional option to be installed. See your Cochlear representative 
for information about regional options. 

Important information  

 Note: Patients need to be enrolled in the Cochlear Remote Check program to be able to 
use Remote Assist. For more information on how to enrol a patient please see the Remote 
Check - Nucleus Smart App - Quick Guide for Clinicians. 

 Note: As with the Custom Sound Pro software, Remote Assist cannot modify a patient's 
MAP if it uses atypical parameters. MAPs using atypical parameter will be displayed as read 
only on the Remote Assist Adjust screen. Some examples atypical MAP parameters are: 

• Mixed pulse widths 

• Pulse widths greater than 100 μs 

• More than 10 electrodes turned off 

• Non-monopolar stimulation modes (i.e. common ground, bipolar etc) 

• Mixed stimulation modes 

• Non-default channel to electrode MAPs or MAPs with channel re-ordering 

• MAPs with narrow (<10CL) dynamic ranges 
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Connect 
Remote Assist session connections are launched from the patient dashboard for eligible 
patients. 

 Note: Patients need to be enrolled in the Cochlear Remote Check program to be able to 
use Remote Assist. For more information on how to enrol a patient please see the Remote 
Check - Nucleus Smart App - Quick Guide for Clinicians. 

Task steps: 

1. Select and open the eligible patient from the patient list. 

2. Click Start Remote Assist on the patient dashboard. 

Or,  

Click Log in to Remote Assist and you will be prompted to log in to myCochlear 
Professional.  

3. Choose your audio and video settings. 

4. Click Start session. 

You will be directed to a lobby to wait until both the patient and the clinician have 
joined the session. 

5. When both parties have joined the session, video and chat functions will be available. 

 Note: To make adjustments the patient will need to disable streaming. Please 
have them refer to their Pairing Guide for steps to disable streaming. Do not have 
them disable Bluetooth.  

6. Click Connect and adjust to make adjustments or Finalise session to finish the 
Remote Assist session. 

Result: 

The Remote Assist session will start with video and chat. 
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Adjust 
Use the Adjust screen in the Remote Assist feature with live speech to set the master 
volume until sounds are comfortably loud for the patient, and then to set bass and treble 
levels to adjust the sound quality they hear.  

You can use the Adjust screen to balance the loudness of bilateral MAPs. Adjust each side 
individually to ensure the same perceived volume and sound quality and set overall 
loudness for each to achieve a comfortably loud sound level. 

Adjust Master Volume to control the overall loudness of all sounds heard by your patient 
and ensure that the patient perceives all sounds at the same comfortably loud level. 

Adjust bass to increase or decrease the volume of low pitched or deep sounds. Adjust 
treble to increase or decrease the volume of high pitched sounds. 

Task steps: 

1. Open the Adjust screen. 

2. If the patient is fitted with two cochlear implants adjust levels for one MAP at a time 

by selecting either Right or Left  to specify the MAP to be adjusted. 

3. Click Master Volume. 

4. Use the Up  and Down  buttons to increase or decrease the loudness. 

5. Click Bass or Treble. 

6. Use the Up  and Down  buttons to increase or decrease the level. 

 Note: For CI500 Series, CI422, Freedom (CI24RE) and Nucleus 24 implants, if you 
exceed the compliance levels on one or more channels, a message displays to 
indicate that there are channels out of compliance. To bring the MAP into 
compliance, click OK. Use the Adjust screen to adjust levels to achieve a comfortable 
loudness level for the patient. 

Result: 

• The master volume, bass or treble are adjusted. 
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Finalise 
Use the Finalise screen to adjust processor settings and save the MAP to a sound 
processor. 

 Tip: The MAP number is shown in the bottom left corner of the program icons. 

 Note: When a new Remote Assist session is started, all MAPs on the sound processor 
will be opened remotely and loaded into the appropriate slots on the Finalise screen. All 
existing program and processor settings on the sound processor will automatically be 
loaded and will appear in the relevant windows when these are displayed. 

1. Ensure the MAP that you want to save to the sound processor is selected. 

2. Adjust processor settings: 

a. Click Processor Settings. 

The Processor Settings screen displays. When the patient has two implants, the 
Processor Settings window displays the information for each in a side by side 
layout, allowing you to view and edit both to ensure they are as similar as 
possible. 

b. Review the processor settings and make any required changes. 

c. Click Save. 

d. Click Save to save any changes. 

 Tip: If you did not make any changes, click Cancel to close the Processor 
Settings window. 

3. Click Save to write the programs to the sound processor. 

A Save successful message appears when the configuration has been written to 
the sound processor. 

4. Click Clinical Report and then print the report if you want to provide a report for 
other clinicians or for clinical records. 

5. Click Hang Up + End session to exit the video and chat and end the fitting session or 
End session end the fitting session if the patient has already left the call. 

If any unsaved changes to MAPs are present, a save confirmation message appears. 
Click Yes to save MAP changes. 

The Patients screen displays, and the Session Details and Take Home reports display 
in separate tabs in the Report Viewer. 

6. Click the Close button  to close each of the reports in the Report Viewer. 
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View usage data for CP900 Series or later Sound Processors 
Custom Sound Pro software comes with a wireless data logging capability where key usage 
information is displayed at a glance to easily track patients' hearing progress. The 
collected data provides insights on user compliance and information to assist in managing 
programs. The CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - 
Nucleus 7 SE, CP1000 - Nucleus 7 and CP900 Series Sound Processors continuously and 
automatically record the input to the microphones, and the buttons and settings used by 
the patient, which are then provided mostly as a daily average proportionate percentage. 

The data usage shown is for individual sound processors. If a patient has multiple sound 
processors per ear, usage data is collected and shown separately for each sound 
processor. 

To view usage data: 

1. Select the patient from the list of patients on the Patient screen.  

2. Click the View Usage Data button (at the bottom left of the screen), or click Patient in 
the dropdown menu (at the top of the screen) and select View Usage Data. 

The Usage Data Viewer can be accessed at any point when the patient's record is 
open. 

The Usage Data Viewer panel displays pie charts showing daily averages for Time on 
Air (for Nucleus 22 implants, this is Time On), Scenes and Program usage. 

 Note: For a bilateral patient two sets of data display. 

3. To view Loudness data, click on the Show button to the left of the Scenes graph and 
select Loudness. The Loudness data displays. 

4. To view Accessory usage, click on the Show button to the left of the Program usage 
graph and select Accessory usage. The Accessory usage data displays. 
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Trend graphs: For Time on Air (for Nucleus 22 implants, this is Time On), Scenes and 
Loudness, a trend graph is displayed under the pie chart display data for the last 5 periods. 
If the mouse is rolled over each of these graphs, they display the length of each period in 
days. 

 Note: Each period corresponds to the dates the sound processor is connected to 
Custom Sound Pro software. 

Volume or Sensitivity can be selected by moving the rollover switch under the Program 
usage pie chart. This controls whether volume or sensitivity information is shown when the 
mouse is rolled over the chart. 

Accessory Usage: If the mouse is rolled over the Accessory usage pie chart, the number of 
uses of the three most used accessories during the last period is displayed. Usage of all 
accessories is shown in the table below the pie chart. 

 Note: The sound processor does not need to be connected to see previous periods. Up 
to five periods are shown in the Usage Data Viewer. 
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Patient Goals  
Use the Patient Goals screen to record and track patient goals, and to view your patients 
hearing achievements and the details of all previously set goals. 

The screen contains two tabs: 

• Current Patient Goals specifies up to five goals that the patient is currently trying to 
achieve. 

• Goal History lists the patient's achievements and all previously set goals. This helps 
you to track and highlight their progress, and to see what has worked previously for 
goals in the same category. 

Goals automatically appear in the patient's take-home report, so they can review them at 
home. 

Manage patient goals  
Use the Current Patient Goals tab of the Patient Goals screen to encourage focus on the 
patient and achieving their goals. 

You can have up to five goals open at any one time, each with a goal statement, an action 
plan, a category label chosen from a pre-defined set, and an ability rating indicating the 
current level of achievement. 

Goals can be edited, deleted or marked as complete, and the goal actions appear in the 
patient's take home report. 

From the icons at the top right of the Patient Goals screen you can also view the patient's 
current Usage Data and create session notes for recording goals. 

Task steps: 

1. Click on Patient Goals in the Dashboard screen. 

The Patient Goals window displays with the Current Patient Goals tab selected. 

To add a goal: 

a. Click Add  icon. 

b. Select a Category from the drop-down list. 

c. Describe the patient goal. 

d. Describe the action plan to achieve the goal. 

e. Select an Ability Rating to indicate the current completion of the goal. 
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To edit a goal: 

a. Select a different Category from the drop-down list. 

b. Update the patient goal or action plan text. 

c. Select a new Rating. 

 Previous ratings will appear in a lighter shade. 

To complete a goal: 

• Select the Done check box beside the goal to indicate it is complete. 

The goal remains visible in the Goal History tab. 

To remove a goal: 

• Click the Delete  icon. 

The goal is deleted and can no longer be viewed. 

2. Click Save to save any changes made to goals and close the Patient Goals screen. 

Result: 

• The patient's current goals are accurately recorded. 

View goal history  
View all previously set patient goals. 

Task steps: 

1. Click on Patient Goals in the Dashboard screen. 

The Patient Goals window displays with the Current Patient Goals tab selected. 

2. Click the Goal History tab. 

All previously set goals display, showing their start dates, achievement or deletion 
dates and goal categories. 

3. Click on a goal to expand it and display the goal description, action plan, last ability 
rating, and the Done check box. 

4. Uncheck the Done check box to make it a current patient goal. 

5. Click Save to save any changes made in patient goals and close the Patient Goals 
screen. 

Result: 

• The patient's current goals are accurately recorded. 
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View session history details 
The details of each programming session are saved in Custom Sound Pro software, and 
previous sessions can be viewed in the Session History window. Notes can be added or 
updated for each session. 

Task steps: 

1. Click on Session > Session History in the Menu bar. 

The Session History window displays. 

2. Click a session in the Session History list. 

The Sound Processor panel displays the environment and MAP number for each 
program written to the sound processor during the selected session. 

3. Select from the following actions in the Sound Processor panel: 

• To view the volume and sensitivity settings for an environment, place the 
cursor over the desired Environment icon. 

• To view the settings for an environment in the Program Settings window, click 
the desired Environment icon. 

• To open a MAP in the Set Levels screen, click the desired MAP link. 

• To view the settings for a CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - 
Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, CP900 Series or CP800 
Series Sound Processor in the Processor Configuration window, ensure the 
correct sound processor is selected and click Sound Processor Configuration. 

• To restore the programs from the selected session to the connected sound 
processor, click Save to Processor. 

4. To add Notes or edit existing Notes for the selected session, type the desired text in 
the Notes panel. 

5. To print a report for the selected session, click Print Report or Print Patient Take 
Home Report in the Session panel and use the Print toolbar on the Report viewer. 
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6. To compare programs: 

a. Hold down the Ctrl key and click the sessions you want to compare in the 
Session History list. 

b. Click Compare Programs in the Session panel. 

The Select Programs window displays a list of available programs for each 
programming session. 

c. Select the check boxes of the required programs and click Compare. 

The Program Comparison window displays the differences between the MAPs 
and the environments. 

d. To test a program using live voice testing, select the sound processor from the 

Processor drop-down list and click the Go Live button  corresponding to 

the desired program. Click the Stop button  to stop live voice testing.  

e. To print the program comparison details, click Print. Type any Notes to be 
added to the report in the Program Comparison Report window and click 
Report. 

The program comparison details display in the Report viewer and can be 
printed using the Print toolbar. 

7. Click the Close button  to close the Session History window. 

Result: 

• Any changes made to the session Notes are saved. 
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Compare programs 
The details of each programming session are saved in Custom Sound Pro software, and 
previous sessions can be viewed in the Session History window. Notes can be added or 
updated for each session. 

Task steps: 

1. Click on Session > Session History in the Menu bar. 

The Session History window displays. 

2. Hold down the Ctrl key and click the sessions you want to compare in the Session 
History list. 

3. Click Compare Programs in the Session panel. 

The Select programs for comparison window displays a list of available programs for 
each programming session. 

4. Select the check boxes of the required programs and click Compare. 

The Program Comparison Report window displays the differences between the MAPs 
and the environments. 

5. To test a program using live voice testing: 

a. Select the sound processor from the Processor drop-down list. 

b.  Click the Go Live button  corresponding to the desired program. 

c. Click the Stop button  to stop live voice testing. 

6. To print the program comparison details, click Print. 

7. Type any notes to be added to the report in the Program Comparison Report window 
and click Report. 

Result: 

• The program comparison details display in the Report viewer (with notes if added) 
and can be printed using the Print toolbar. 
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Measure 
The Measure screen contains the Impedances screen and the AutoNRT® screen which you 
can use to carry out impedance and AutoNRT measurements. 

Patient AutoNRT and impedance data can also be imported into Custom Sound Pro 
software. Prior to importing the data, it needs to be exported from an intraoperative 
remote assistant and saved to a location where it can then be imported from.  

 Note: This option is not available from CR110 or CR230 Remote Assistants. 

Impedances 
Use the Impedances screen to test an implant by measuring the impedance for each 
implant electrode and detecting any short- or open-circuit electrodes. 

If impedances were measured automatically when you selected the sound processor on 
the Dashboard, the Impedances screen shows the electrodes that were measured. If there 
are no results, click Measure to measure impedances. 

Click the Customize button to display the Impedance Measurement Options screen and 
choose stimulation modes, include or exclude electrodes from measurement, add notes to 
individual electrodes, or generate a report displaying the impedance measurement results. 

Click the Details button to display the Impedance Measurement Details screen showing 
the results of the impedance measurement, and to turn off electrodes if required. If you 
turn off an electrode, the impedance measurement will run automatically when you close 
the Impedance Measurement Details screen. Click on an electrode in the schematic 
diagram to display the Impedance Measurement Details screen with the selected electrode 
highlighted. 

Click the Today's Session Notes icon to display an area which is available for you to record 
information about the patient's session. You will be able to view these notes in future 
sessions with the same patient. 

 Notes: 

• Impedances do not auto-run for ABI implants. 

• Implants are automatically set off air while the Impedances screen is displayed. 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 49 

Change measurement settings 
You can specify the way in which electrode impedances are measured using the 
Impedance Measurement Options screen. 

Custom Sound Pro software measures impedances using the following stimulation modes: 

• Common Ground (CG): one electrode is designated as active while the remaining 
electrodes together form the indifferent ‘electrode’. 

• Monopolar (MP1, MP2 and MP1+2): one or both of the extracochlear indifferent 
electrodes is used in combination with intracochlear active electrodes. 

An implant test detects the following short- or open-circuit electrodes: 

• Intracochlear electrodes: detects short- and open-circuit electrodes in Common 
Ground mode, and open-circuit electrodes in Monopolar modes. 

• Extracochlear electrodes: detects open-circuit electrodes in Monopolar modes, but 
does not detect short-circuit electrodes between extracochlear electrodes. 

Task steps: 

1. Click the Customize button. 

The Impedance Measurement Options screen appears. 

2. Select the Stimulation Modes (Common Ground, Monopolar 1, Monopolar 2, 
Monopolar 1+2) which determine which electrodes are stimulated. 

3. Select or clear the Electrodes check boxes as required. 

When selected, the electrode is measured. 

4. Click OK to save the selected options. 

Result: 

• The impedance measurement options are set. 
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Measure impedances 
You can perform an impedance implant test during an intraoperative or postoperative 
session. By default, Custom Sound Pro software measures the impedance of each turned 
off electrode in CG, MP1, MP2 and MP1+2 stimulation modes. 

Task steps: 

1.  (Intraoperative testing only) Place the coil in a sterile bag on the skin flap covering 
the implant.  

2. To change the default measurement settings, click Customise in the Impedance 
screen. 

The Impedance Measurement Options window displays. 

3. Select or clear the desired check boxes to specify which stimulation modes and 
electrodes to test, and click OK. 

4. Click Measure. 

Result: 

• The electrodes for which successful impedance measurements were obtained in all 
stimulation modes display in green . Any electrodes for which short- or open-
circuits were detected display in red , and are automatically turned off in 
postoperative mode only. Turned off electrodes display in brown  in subsequent 
programming sessions. 
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View impedance measurements 
Impedance measurements are stored in Custom Sound Pro software and can be viewed at 
any time. 

Task steps: 

1. Click Details in the Impedances screen. 

The Impedance Measurement Details window displays the impedance 
measurements for each electrode in each stimulation mode.  

Details can be filtered by History (number of past measurements to display) and 
Mode (CG, MP1, MP2 and MP1+2) 

2. Use the check boxes under View to show or hide results for a selected mode on a 
particular implant test date. 

3. Hover over the results for an electrode to see more information. 

4. To turn on or turn off an electrode, right-click the electrode and choose Turn off/on 
electrode. 

The Add note to electrode window displays. Type reasons for turning off/on 
electrode in Notes next to the date stamp and click Save and Close. Electrode Notes 
can be viewed by placing the cursor over the corresponding turned off electrode. 

5. To print a report of the measurement details, click Report and use the Print toolbar 
on the Report viewer. 

Result: 

• The Impedance Measurements window displays a list of the impedance 
measurements obtained for the implant. 

 Note: 

• Electrodes that have been automatically turned off display with an open  or short 

 symbol. Electrodes that have been manually turned off display with a cross 

symbol . 

• This screen can also be accessed by clicking the Implant menu and select 
Impedance Measurement History. 
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Turn electrodes on or off 
You can use the Impedance Measurement Details tab to manually switch off implant 
electrodes, and to attach a note explaining the reason for switching them off. 

Manually turned off electrodes are not used when measuring impedances in postoperative 
mode or when creating new MAPs. Automatically turned off electrodes are retested when 
an impedance test is performed. 

Task steps: 

1. Click the Details button on the Impedances screen. 

The Impedance Measurement Details window displays. 

2. Right-click the desired electrode and choose Turn off/on electrode. 

The electrode is turned off or turned on respectively. 

The Add note to electrode window appears. 

3. Type an informational note about the electrode for example reasons for turning 
off/on electrode into the text box. 

4. Click Save and Close to close the Add note to electrode window. 

Electrode notes can be viewed by placing the cursor over the electrode that has been 
turned off. 

5. Click OK to close the Impedance Measurement Details window.  

Result: 

• The selected electrodes are now either turned on or turned off as required. 

 Note: Electrodes can also be turned on or off in the same manner from the Comfort 
screen. 
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AutoNRT 
Use the AutoNRT screen to measure NRT® threshold levels. Neural Response Telemetry 
(NRT) records neural activity within the cochlea in response to electric stimulation from the 
implant, and NRT threshold measurements can be used to create a MAP. 

When you start AutoNRT, both sides are taken off air, and returned on air afterward. 

Click the  to: 

• Specify the Number of Electrodes (3, 5, 9, or All) if this is different from the default. 

 Note: By default, Custom Sound Pro software sets the number of electrodes to 5 
(where available) and selects an even distribution along the array. You can change 
the default number in the AutoNRT tab of the Clinician Details and Preferences 
window, or click the Channel Numbers in the Channel Grid to select or de-select 
individual channels for measurement. 

• Set the starting current level (CL) to be used in the measurement. 

• Display the AutoNRT traces window showing stimulation responses as the 
measurement process takes place. 

The NRT Traces window displays in front of the AutoNRT screen. 

The changes you make in  apply for the current session only. Use the NRT tab of the 
Clinician Details and Preferences window to set persistent default values for AutoNRT 
parameters such as the number of electrodes to be measured, whether or not the NRT 
traces window appears, and Intraoperative and Postoperative options. 

Click the Details button to open the NRT Levels window. Here you can select past NRT 
measurements to view. These measurements are only shown in the NRT Levels window for 
reference and do not affect the current MAP appearance or function. 

 Notes: 

• An impedance test must be performed prior to obtaining NRT measurements. Any 
electrodes identified as faulty by this test are not measured. 

• The AutoNRT function is not available for ABI541, Nucleus 24 or Nucleus 22 implant 
types. 
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Task steps: 

1. Select the AutoNRT screen. 

2. Click Start. 

Starting at the specified current level, the NRT level gradually increases by the 
default step size until the threshold is detected for each selected channel in turn. The 
defaults for both current level and step size are set in the Clinician Details and 
Preferences window. 

 Note: To stop AutoNRT at any time, click Stop or the Esc key. Click Continue when 
you are ready to continue, or click Skip Electrode to skip the currently selected 
electrode and measure the next one. 

An information message displays when the measurements are complete. 

3. To measure additional electrodes, select a larger value in the Number of Electrodes 

box in the  or select more Channel Numbers in the Channel grid, and then 
repeat the measurement process. 

Result: 

• The measured NRT values are saved and available for use when programming MAPs. 

 Notes: 

• (Intraoperative mode only) By default, each electrode is conditioned at 230 current 
levels prior to measuring the NRT level. 

• (Intraoperative mode only) Enhanced interpolation can be selected as a clinician 
preference, enabling automatic interpolation of NRT levels when the distance 
between two measured electrodes is less than 8 channels. Measurements are 
obtained 6 CL above and below the interpolated thresholds. If a neural response is 
detected above the threshold and none is detected below, the interpolated value is 
selected. If no response is detected above the threshold or one is detected below, 
standard AutoNRT is performed. 

NRT Traces 
Use the NRT traces screen to view the results of NRT measurements to determine if the 
NRT measured is a true response. If there is a negative and positive peak it is a true 
response. 

 Note: You can set the NRT Traces window to display automatically when performing 
AutoNRT by selecting Show traces during AutoNRT in the AutoNRT tab of the Clinician 
Details and Preferences screen. 
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Export data from an intraoperative remote assistant 
You can export AutoNRT and impedance data from an intraoperative remote assistant to a 
.crf file for future importation to a patient record. 

Task steps: 

1. Connect the intraoperative remote assistant. 

2. Right-click on the remote assistant icon in the status bar. 

3. Select Export AutoNRT and Impedance measurements. 

The Export Remote Assistant AutoNRT and impedance measurements to window 
displays to allow you to select the file location. 

4. Navigate to the location you wish to save the .crf file. 

5. Click Save. 

Result: 

• The .crf file is saved to the selected location. 
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Import patient data into Custom Sound Pro software 
You can import patient data into Custom Sound Pro software that has previously been 
exported from an intraoperative diagnostic device. 

Task steps: 

1. Click the File menu and select Import Intraoperative Data. 

2. Select where to import the data from. 

The Import Intraoperative Data window displays with the following options: 

• Browse cloud data - can be selected if no patient session is currently open and 
allows the import of intraoperative data linked to the current clinic set in 
Custom Sound Pro software from the Cochlear Cloud. 

• Import from local file - can be selected if no patient session is currently open 
and allows the import of intraoperative data from a local file. 

• Check cloud data via implant ID - can be selected if a patient session with a 
known implant ID is open. It allows the import of intraoperative data for the 
current patient from the Cochlear Cloud. 

 Note: For Check cloud data via implant ID, the interoperative data of the 
patient does not need to be linked to the current clinic set in Custom Sound Pro 
software.  

 Note: For Browse cloud data and Check cloud data via implant ID you will 
need to login to myCochlear Professional with your email and password. If you do 
not have a myCochlear Professional login, contact your Cochlear representative.  

3. Navigate to the data or local .crf file you want to import. 

4. Click Open. 

5. For local files, enter the password for the file if prompted. 

 Note: Some files will be password protected on export. 

The data is imported into Custom Sound Pro software. 
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Result: 

For intraoperative data that does not contain additional patient information: 

• After the data import process has completed, displays the results depending on the 
success of the import: 

• If no new valid data has been saved to the database, Custom Sound Pro 
software displays a message to indicate no changes have been made, or 

• If the data has been saved to a database, Custom Sound Pro software displays 
a message to indicate that surgical measurements were saved to the database. 

• When a .crf file is imported into Custom Sound Pro software, the intraoperative data 
is saved to the database. However, the intraoperative data is not associated with a 
patient at this stage. 

• When the coil is placed on the patient's head, Custom Sound Pro software checks for 
unassociated intraoperative data that matches the patient's Implant ID. If one or 
more matches are found, a message displays to select the appropriate intraoperative 
data record for the patient. The message is colour coded to differentiate between 
records for right (red) and left (blue) ear implants. Intraoperative data records older 
than 4 months are ignored. 

  

For intraoperative data that contains additional patient information (.crf3): 

• After the file import process has completed, the Import Intraoperative Data window 
will be shown with the options: 

• Create new patient - a new patient record will be created in the database 
based on the intraoperative data. 

If a patient exists with the same implant ID, then a message will display 
confirming that a new patient record should be created.  

• Associate data - Custom Sound Pro software will attempt to match the patient 
information from the intraoperative data with existing patient records in the 
database. The Import Intraoperative Data window will display a list of any 
potential matches for selection. If no matches are found, or are not correct, the 
patient list can be used to select from existing patient records. 

To associate the intraoperative data with an existing patient record: 

1. Select a patient record from the potential matches or from the patient 
list. 

2. Click Associate data. 

The intraoperative data will now be associated with the selected patient. 

• Cancel - the intraoperative record is not saved to the database and the Import 
Intraoperative Data window will close. 
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Adjust 
Use the Adjust screen to create and open MAPs, and make adjustments to Master Volume, 
bass, treble, comfort and thresholds that are suitable for your patient. 

Select MAP 
The MAP screen allows you to create a new MAP or open an existing MAP. Where changes 
are made to an existing MAP, a new MAP is automatically created allowing the original 
MAP to be preserved.  

Create or open a MAP 
The MAP screen allows you to create a new MAP or open an existing MAP. Where changes 
are made to an existing MAP, a new MAP is automatically created allowing the original 
MAP to be preserved. 

To create a new MAP: 

Task steps: 

1. Select the sound processor and the desired MAP parameters from the drop-down 
lists in the Create a New MAP area. 

It is recommended the default parameters are used during an initial activation. 

 Note: For CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7 and CP900 Series Sound Processors, the Hybrid Mode check box 
is available on the Open or Create MAP screen if an audiogram has been created for 
the patient. Refer to Program an acoustic component for further information on 
acoustic programming. 

2. CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - 
Nucleus 7 Sound Processors: For Hybrid MAPs, select the receiver type from the 
drop-down list. 

Based on the patient's audiogram, the most suitable receiver type is highlighted in 
the list. If you do not select a receiver type, you cannot proceed. 

 Note: Ensure the correct receiver type is selected so that the appropriate gain 
and MPO can be applied. 
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3. Point to the Create button to display the Create New MAP Based On menu and click 
one of the available options: 

• Latest AutoNRT creates a MAP based on most recent valid NRT values. 

This option is only available when NRT has been run and there are more than 3 
measures. It is not available for ABI541, Nucleus 24 ABI and Nucleus 22 
implants. 

• Population mean creates a MAP based on population mean values. 

Not available for ABI541, Nucleus 24 ABI and Nucleus 22 implants. 

• Other measures displays the Select NRT/Objective levels screen.  

This is available when there are measurements (NRT, AutoNRT, EABR, etc.) but 
not available for ABI541, Nucleus 24 ABI and Nucleus 22 implants. 

• Thresholds creates a MAP with C levels set at 90 CL and T levels set at 80 CL on 
the Thresholds screen. 

Result: 

• The MAP is created using the specified parameters. 

Each MAP is assigned a number, incremented by one for each successive MAP. 

 Note: When you create a new ABI541 or Nucleus 24 ABI MAP, a message displays 
indicating that the electrode number ordering is reversed the new MAP. Refer to the 
channel numbering in the lower portion of the screen. Channel 1 is the highest frequency 
and Channel 22 is the lowest frequency. 

To open an existing MAP, double-click the MAP in the MAP list. 

To open multiple MAPs: 

1. Select a MAP, press the Ctrl key and select other MAPs. 

2. Right-click the selected MAPS and select Open. 

To open a MAP from the sound processor, right-click on the Program  in the status bar 
and select Open MAP. 

 Note: The patient must be off air for the Open MAP option to be available. 

The selected MAP or MAPs then generally open in the Global Adjustments screen. 

To save a MAP at any time, click the Save MAP button  on the Set Levels toolbar, or 
click the MAP menu and select Save or Save All. 

To close a MAP, click the Close MAP button  on the Set Levels toolbar, or click the MAP 
menu and select Close or Close All. 
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Upgrade or convert a MAP 
An existing MAP can be upgraded or converted for use with a different sound processor 
type. Custom Sound Pro software provides the following options: 

• Upgrade MAP: the frequency table and as many parameters as possible are set to 
the defaults of the new sound processor. 

• Convert MAP: where possible, the frequency table of the original MAP is copied to 
the new MAP. If the frequency table cannot be copied, Custom Sound Pro software 
adjusts the frequency boundaries or uses the default table for the new sound 
processor.  

 Note: 

• To convert or upgrade existing Spectra or ESPrit Series Sound Processor MAPs to 
CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7 or CP900 Series Sound Processors, you must first convert or 
upgrade the MAP to Freedom Sound Processors and then convert the generated 
Freedom Sound Processor MAP to CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - 
Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7 or CP900 Series Sound 
Processors. The same is also true for patients with Nucleus 22 implant types when 
upgrading to CP900 Series Sound Processors. 

• MAP conversions are available from Freedom Sound Processors onwards (including 
Freedom Hybrid). MAP upgrades are not available from Freedom Sound Processors 
onwards (including Freedom Hybrid). 

• The MAP Summary window is only available for Nucleus 24 and Nucleus 22 implant 
types. 
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Task steps: 

1. Select the MAP you want to upgrade or convert. 

2. Click the MAP menu and select Upgrade MAP or Convert MAP. 

A list of sound processor upgrade or conversion combinations appears. 

3. Select the appropriate sound processor combination. 

The values of the original MAP are copied to a new MAP. Parameter values that are 
invalid for the new MAP are set to the default values for the new sound processor 
type. 

For CP900 Series Sound Processors and later when you click 'convert' a message is 
displayed asking if you want to copy settings. 

• If you choose 'Use Default' then the MAP will be converted, but global defaults 
for programs/ processor settings will be set for the selected processor type. 

• If you choose 'Copy previous' then it will copy across the existing programs 
and processor settings where possible (with previous settings coming from 
processor or database). 

For any settings that were not available on the old processor will be set to default 
settings.  

4. For Nucleus 24 and Nucleus 22 implant types only, details of the changes display in 
the MAP Summary window. 

• To print a report of the changes, click Print Summary and use the Print toolbar 
on the Report viewer. 

• To add details of the changes to the MAP notes, select Add Summary to the 
MAP Notes of the New MAP, and click OK. 

• MAP notes are saved with the MAP and added to MAP reports. 

Click the Close button to close the MAP Summary window. 

Result: 

• The new MAP displays in the Select or Create a MAP list in the Select Map tab of the 
Adjust tab. 
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Compare MAPs 
The MAP Compare function allows you to compare up to four different MAPs, including 
those created for different sound processors and different implants. 

To compare MAPs created for the same implant: 

Task steps: 

1. Press the Ctrl key and select the MAPs you want to compare in the MAP list. 

2. Right-click the selected MAPs and select Compare MAPs. 

The MAP Comparison window displays the differences between the MAPs, including 
the T and C levels, pulse width, gains and frequency boundaries for each channel. 

3. To test a MAP using live voice testing, select the sound processor from the Processor 

drop-down list and click the Go Live button  corresponding to the desired MAP. 

Click the Stop button  to stop live voice testing. 

4. To print the MAP comparison details, click Print. Type any notes to be added to the 
report in the MAP Comparison Report window, and click Report. 

Result: 

• The MAP comparison details display in the Report viewer, and can be printed using 
the Print toolbar. 

To compare MAPs created for bilateral implants: 

Task steps: 

1. Select one of the MAPs you wish to compare in the MAP list. 

2. Right-click the MAP and select Compare with Another MAP. 

The Select MAPs window displays a list of available MAPs for each implant. 

3. Select the check boxes of the required MAPs and click Compare. 

Result: 

• The MAP Comparison window displays the differences between the MAPs. 

 Note: Custom Sound Pro software also allows you to compare programs from previous 
sessions. See View session history. 
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Manage MAPs 
Use the Manage MAPs screen to archive MAPs which are no longer to be used, and to 
restore previously archived MAPs so they can be used again. 

Archive a MAP 
MAPs that are no longer required can be archived from the MAP list. MAPs that have been 
archived can be restored and used again. 

Task steps: 

1. Click on MAP > Manage in the Menu bar. 

The Manage MAPs window displays. 

2. Select the MAP you want to archive in the Active list. 

3. Click Archive. 

The MAP moves from the Active list to the Archived list, and is no longer visible in the 
MAP screen. 

4. Click the Close button  to close the Manage MAPs window. 

Result: 

• The MAP is archived and can no longer be accessed in Custom Sound Pro software 
other than to be restored. 

Restore a MAP 
MAPs that have been archived can be restored and used again. 

Task steps: 

1. Click on MAP > Manage in the Menu bar. 

The Manage MAPs window displays. 

2. Select the MAP you want to restore in the Archived list. 

3. Click Restore. 

The MAP moves from the Archived list to the Active list, and is restored to the MAP 
screen. 

4. Click the Close button  to close the Manage MAPs window. 

Result: 

• The previously archived MAP is now available for use. 
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Acoustic 
Use the Acoustic screen to configure the acoustic parameters for a Freedom Hybrid, a 
CP900 Series, CP1000 - Nucleus 7, CP1001 - Nucleus 7 SE, CP1002 - Nucleus 7 S or CP1110 - 
Nucleus 8 Sound Processor based on the patient's pure tone audiometric data. Gain and 
maximum power output (MPO) can be programmed for the low frequency range of 
hearing. 

You can balance loudness using electrical stimulation alone, or with electrical and acoustic 
stimulation combined. 

 Notes: 

• The Acoustic screen is available only when a Hybrid MAP is selected. 

• Acoustic channels can be enabled or disabled if required. Audiometric points within a 
disabled band are not used for prescription. 

 
Key: 

1. Enabled channels. 

2. Selected channel. 

3. Disabled channel. 

4. MPO: Maximum Power Output. 

5. Target MPO. 

6. Simulated Aided Gain (at 60dB SPL): the difference between the level of sound into 
the hearing aid and the output. 

7. Target Gain (at 60dB SPL). 
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Set acoustic parameters 
Custom Sound Pro software allows you to set the acoustic parameters for a Freedom 
Hybrid, a CP900 Series, CP1000 - Nucleus 7, CP1001 - Nucleus 7 SE, CP1002 - Nucleus 7 S or 
CP1110 - Nucleus 8 Sound Processor based on the patient's pure tone audiometric data. 
Gain and maximum power output (MPO) can be programmed for the low frequency range 
of hearing. 

Task steps: 

1. Click the Acoustic tab in the Adjust screen, or click the Acoustic button  on the 
Set Levels toolbar. 

The Acoustic screen displays. 

2. If the patient does not have an audiogram, or their audiogram needs to be updated, 
click View Audiogram. 

The Audiogram tab of the Patient Details window displays in Add / Edit mode. 

a. Click AC  to select air conduction thresholds. 

b. Click the audiogram to enter the thresholds. 

Use the right-click menu to mark a point as no response. A no response entry 
does not contribute to the prescription. 

c. Click Save to save the audiogram entries and close the Patient Details window. 

d. Select a Receiver Type in the Set Prescription panel. The most suitable type is 
identified in the list with a  symbol. 

 Note: A recent postoperative audiogram is required. If an existing audiogram has 
not been reviewed in the past twelve months, a new audiogram should be entered. 

3. Select Show 2CC Values or Show Real Ear Values from the drop-down list. 

The Frequency Graph displays four curves: Target MPO and Aided MPO (OSPL 90), 
and Target Gain and Simulated Aided Gain (60 dB SPL input). The lower frequency 
boundary for electric stimulation is automatically set based on the patient's 
audiogram. 

4. Select a prescription method (DSL or NAL) from the Method drop-down list in the 
Set Prescription panel, and click the WDRC or Linear option button. 

NAL and WDRC are selected by default. 
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5. CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - 
Nucleus 7 Sound Processors: Select the receiver type if it has not already been set. 

If multiple MAPs are being written to the sound processor, make sure the receiver 
type is the same for all MAPs. 

 Note: If the receiver type is not set, the prescription cannot be calculated and you 
cannot go On Air. 

6. Select mould type: 

CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - 
Nucleus 7 Sound Processors: Custom, Power Dome, Bass Single Dome, Bass Double 
Dome, or Open Dome. 

The most suitable mould type is highlighted in the list with a  symbol. 

 If multiple MAPs are being written to the sound processor, make sure the mould 
type is the same for all MAPs. 

CP900 Series Sound Processors: Custom, Power Dome, or Plus Dome. 

If Custom ear mould is selected, also select a vent size (0, 1, 1.4, 2.4, or 3 mm) in Vent 
Size. 

Freedom Hybrid Series Sound Processors: Select the vent size (0, 1, 1.4, 2.4, or 3 
mm) in the Vent Size field.  

Custom Sound Pro software automatically recalculates the gain and MPO levels. 

7. Click the MPO or Gain option button based on the amplification characteristics you 
wish to set. 

8. Select the step size (1 or 3). 

The step size units for MPO are dB SPL and for Gain are dB. 

9. Ensure the sound processor is  Off Air. 

10. Clear the Mute Acoustic check box. 

  Note: You can only set or clear the Mute Acoustic check box when the sound 

processor is  Off Air. 
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11.  Set the sound processor to  On Air. 

12. Select the frequency bands to be modified. Selected bands are highlighted on the 
graph in yellow: 

• Click on a band to select that band and deselect all others. 

• Double-click on the graph to select all non-disabled bands. 

• Click and drag to select multiple bands. 

• Right-click on a band to display the enable / disable popup menu. Click on the 
menu option to enable or disable that band. 

 Notes: 

• Disabled bands are shown in grey. 

• Only the last active band at either end of the active range can be 
disabled. 

• A disabled band can only be enabled if it is adjacent to an active band. 

13. Use the left Increase  and Decrease  buttons to adjust the level on the 
selected channels. 

 Tip: To reverse your channel level adjustments, Set Prescription modifications, 
and Frequency Boundary changes, click Undo in the MAP menu. Restore them by 
clicking Redo. 

14. Set the sound processor to  Off Air to stop live voice testing. 

Result: 

• The acoustic parameters for the Sound Processor are set. 
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To balance loudness for CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7 and CP900 Series Sound Processors: 

1. Go live using acoustic stimulation only: 

a.  Remove the coil from the patient’s implant. 

b. Ensure the sound processor is  Off Air. 

c. Clear the Mute Acoustic check box. 

d. Set the Acoustic indicator to  On Air. 

2. Obtain a loudness rating of ‘comfortable but slightly soft’ by adjusting the overall 
gain only. 

3. Return the coil to the patient's implant. 

4. Go live using electric stimulation only: 

a. Set the Acoustic indicator to  Off Air. 

b. Set the Mute Acoustic check box. 

c. Set the Acoustic indicator to  On Air. 

5. Obtain a loudness rating of ‘comfortable but slightly soft’. 

6. Go live using both electric and acoustic stimulation: 

a. Set the Acoustic indicator to  Off Air. 

b. Clear the Mute Acoustic check box. 

c. Set the Acoustic indicator to  On Air. 

7. Confirm an overall loudness rating of comfortable. 

  

 Note: 

• Additional acoustic channels can be added if required by right-clicking on the lowest 
deactivated channel (i.e. in the shaded grey area) and selecting Enable Channel. 
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Global Adjustments 
Use the Global Adjustments screen with live speech to set the master volume until sounds 
are comfortably loud for the patient, and then to set bass and treble levels to adjust the 
sound quality they hear. Adjustments to the master volume are always required after 
creating an initial hearing profile.  

You can use the Global Adjustments screen to balance the loudness of bilateral MAPs 
simultaneously as the two MAPs display side by side. Adjust each side individually to 
ensure the same perceived volume and sound quality, then link the two sides and set 
overall loudness to achieve a comfortably loud sound level. 

Click the  to: 

• Switch on the stimulation heard by the patient. 

• Set the On air volume of the beeps that stimulate the cochlear implant using the  

and  drop-down lists. 

• Specify whether Master Volume, Bass, and Treble adjustments apply to both C and T 
levels (T & C), C levels only (C), or T levels only (T). 

• Specify whether changes are made in step size or by a percentage of the dynamic 
range. 

• Set the NRT profile displayed as view only from the Select NRT levels screen using the 

NRTs, or NRTs button. 

• View a subset of the MAP parameters, or click  Open, or  Open to display the 
Parameters window to view and modify a larger set of MAP parameters. 

Click off the  to close. 
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Unilateral display: 

 
Key: 

1. Compliance limits for each electrode (if set in the Clinical Details and Preferences 
screen). 

2. NRT values (if set in the Clinical Details and Preferences screen Adjust tab). 

 Note: only NRT values greater than zero (those for which AutoNRT is measured) 
are shown. 

3. The expected range of C levels, based on either the patient's AutoNRT results or the 
population average, which can assist you in setting the Master Volume. Some 
patients will need to have their C level set above or below this range.  

4. The current C levels of the electrodes, shown as red markers when adjustable and 
grey markers when not currently adjustable in this screen. 

5. The current T levels of the electrodes, shown as green markers when adjustable and 
grey markers when not currently adjustable in this screen. 
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Bilateral display: 

 
Key: 

1. The Link icon. Visible only when programming a bilateral patient. 

2. Compliance limits for each electrode (if set in the Clinical details and preferences 
screen). 

3. NRT values (if set in the Clinical Details and Preferences screen Adjust tab). 

 Note: only NRT values greater than zero (those for which AutoNRT is measured) 
are shown. 

4. The expected range of C levels, based on either the patient's AutoNRT results or the 
population average, which can assist you in setting the Master Volume. Some 
patients will need to have their C level set above or below this range. 

5. The current C levels of the electrodes, shown as red markers when adjustable, and 
grey markers when not currently adjustable in this screen. 

6. The previous C levels of the electrodes. 

7. The current T levels of the electrodes, shown as green markers when adjustable, and 
grey markers when not currently adjustable in this screen. 

8. The previous T levels of the electrodes. 
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Adjust Master Volume 
Adjust Master Volume to control the overall loudness of all sounds heard by your patient 
and ensure that the patient perceives all sounds at the same comfortably loud level. 

Task steps: 

1. Open the Global Adjustments screen. 

 Note: If the patient was on air before navigating to the Global Adjustments 
screen, they remain on air. If the patient was off air, they remain off air. 

2. If the patient is fitted with two cochlear implants: 

• To adjust levels for both MAPs at the same time and by the same amount, 
ensure the Link is closed: . 

• To adjust levels for one MAP at a time, ensure the Link is open: and select 

either Right or Left  to specify the MAP to be adjusted. 

3. Click Master Volume. 

4. Use the Up  and Down  buttons to increase or decrease the loudness. 

To change the size of adjustments, click in the Step size box below the buttons and 
either type a new value or use the keyboard  or  arrow keys to increase or 
decrease the value. 

 Note: For CI500 Series, CI422, Nucleus Hybrid, Freedom (CI24RE) and Nucleus 24 
implants, if you exceed the compliance levels on one or more channels, a message 
displays to indicate that there are channels out of compliance. To bring the MAP into 
compliance, click Continue. The pulse width is changed across all electrodes and the 
T and C levels are reduced. Use the Global Adjustments screen to adjust levels to 
achieve a comfortable loudness level for the patient. 

 Tip: To reverse your Master Volume adjustments, type Ctrl + Z or click Undo in 
the MAP menu. Restore them by typing Ctrl + Y or clicking Redo. 

Result: 

• The master volume is adjusted. 
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Adjust Bass and Treble 
Adjust bass to increase or decrease the volume of low pitched or deep sounds. Adjust 
treble to increase or decrease the volume of high pitched sounds. 

Task steps: 

1. Open the Global Adjustments screen. 

 Note: If the patient was on air before navigating to the Global Adjustments 
screen, they remain on air. If the patient was off air, they remain off air. 

2. If the patient is fitted with two cochlear implants: 

• To adjust levels for both MAPs at the same time and by the same amount, 
ensure the Link is closed: . 

• To adjust levels for one MAP at a time, ensure the Link is open: and select 

either Right or Left  to specify the MAP to be adjusted. 

3. Click Bass or Treble. 

4. Use the Up  and Down  buttons to increase or decrease the level. 

Your changes are saved when you select Save in the Finalise screen. 

 To change the size of adjustments, click in the Step size box below the buttons and 
either type a new value or use the keyboard  or  arrow keys to increase or 
decrease the value. 

 Note: For CI500 Series, CI422, Nucleus Hybrid, Freedom (CI24RE) and Nucleus 24 
implants, if you exceed the compliance levels on one or more channels, a message 
displays to indicate that there are channels out of compliance. To bring the MAP into 
compliance, click Continue. The pulse width is changed across all electrodes and the 
T and C levels are reduced. Use the Global Adjustments screen to adjust levels to 
achieve a comfortable loudness level for the patient. 

 Tip: To reverse your bass and treble adjustments, type Ctrl + Z or click Undo in 
the MAP menu. Restore them by typing Ctrl + Y or clicking Redo.  

Result: 

• The Bass and/or Treble settings are adjusted. 
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Adjust MAP parameters 
MAP parameters are applied when a MAP is created. You can adjust them when required. 

Task steps: 

1. Click  Open or  Open in the  on the Global Adjustments, Comfort, or 
Thresholds screen. 

Or, click the MAP Parameters button  on the Set Levels toolbar. 

The Parameters window displays. 

2. Adjust the desired boxes. 

 Note: You will need to take your patient off air to adjust some of the parameter 
settings. 

 Note: If you make a change to a parameter that automatically alters the value of 
another parameter, a notification will appear. 
For example: "The following parameters are altered by changing Pulse Width (µs) • 
Maxima". 

3. Click Close  to save the changes and close the Parameters window. 

Result: 

• The MAP parameters are adjusted. 
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The following parameters are available in the Parameters window based on the type of 
sound processor:  

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid and Freedom sound 
processors 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid and Freedom sound 
processors 

Strategy:  The sound coding strategy defines how the sound processor will analyse 
acoustic signals and code them for delivery to the implant.  

Stimulation 
Mode: 

 The stimulation mode determines the location of the indifferent 
electrode relative to the active electrode, and is applied here at MAP level. 
The stimulation mode / indifferent electrode and the active electrode can 
be modified on a per channel basis using the Data Grid on the Set Levels 
screen.  

Channel 
Rate: 

The channel rate (or stimulation rate) determines the frequency in Hertz 
(Hz) of the biphasic current pulse delivered to a channel. The channel rate 
applies to all channels in a MAP. 

Maxima: The maxima is a parameter of the SPEAK, ACE™ and MP3000™ sound 
coding strategies, and refers to the frequency ranges in an audio signal 
that contain the greatest amounts of energy. The value specifies the 
number of maxima that will be selected for any given signal. 

Pulse Width 
(µs): 

The value specifies the duration of the pulse in microseconds, and is 
applied here at MAP level.  
For CI500 Series, CI422, Nucleus Hybrid, Freedom (CI24RE) and Nucleus 24 
implants, when you increase the pulse width, the dynamic range is 
maintained but the T and C levels are reduced. Shift levels using the T & C 
option to adjust levels to achieve a comfortable loudness level for the 
patient. When you decrease the pulse width, the dynamic range and T 
and C levels are maintained. 
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Power Level 
Setting: 

Custom Sound Pro software allows an automatic or manual power setting 
to be applied to a MAP. It is recommended Auto Power is used wherever 
possible, enabling the power level for the sound processor to be 
automatically optimised. 

Tone Level 
(%DR) 

Specifies the loudness of tones as a percentage of the dynamic range.  

Tone Channel  Specifies the channel used for tones to indicate successful key press 
actions (for example, when changing volume levels). 

Low Tone 
Channel 

Specifies the channel used for tones to indicate unsuccessful key press 
actions or warnings (for example, low battery warnings).  

Amplitude 
Scale 

The amplitude scale defines the amount of charge delivered for each 
stimulation, and the type (current level, stimulus level) can be selected for 
Nucleus 22 implants only. 

  

Select NRT levels 
NRT measurements obtained via Custom Sound Pro software can be used as a guide for 
setting T and C levels. NRT measurements must be selected in order for them to be 
displayed on the Adjust screens. 

Task steps: 

1. Click NRTs, or NRTs button from under the  . 

The Select NRT Levels window displays. 

2. Select the type pulse width from the drop-down list. 

3. Select the measurements you want to use. 

Multiple measurements can be selected by holding down the Ctrl key and clicking 
the required measurements. 

4. Click OK. 

Result: 

• The NRT levels markers for the measured channels are display on the Adjust screens. 
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Comfort 
Use the Comfort screen to check that all sounds are comfortably loud for the patient. The 
objective is to alleviate any discomfort the patient might report with certain loud sounds. 

Comfort is checked by playing eight different sounds evenly spaced in bands across the 
implant. To check that all eight bands are comfortably loud, a sweep across all bands plays 
a scale of beeps to the patient. If the patient indicates a band is too loud, you can adjust 
the loudness for that particular band. 

 Note: For most sound processors, each band swept in the Comfort screen stimulates 
three adjacent electrodes simultaneously. Freedom sound processors only sweep a single 
channel, stimulating only one electrode of each band. Three channel beeps may sound 
louder than a single channel sweep. 

While in the Comfort screen you can: 

• Save the current MAP by clicking the Save option in the MAP menu. 

• Specify the current MAP's title and add explanatory text by clicking the MAP title 
and notes option in the MAP menu to bring up the Title and Notes window. 

• Click the  to: 

• Switch on the stimulation heard by the patient. 

• Specify whether sweep is made at C level or at a percentage of the dynamic 
range. 

 Note: Sweeps at a percentage of the dynamic range can only be performed 
on individual electrodes, not on bands. 

• Set the NRT profile displayed as view only from the Select NRT levels screen 

using the NRTs, or NRTs button. 

• View a subset of the MAP parameters, or click Open or Open to display 
the Parameters window to view and modify a larger set of MAP parameters. 

Click off the  to close. 
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Key: 

1. Compliance limits for each electrode (if set in the Clinical details and preferences 
screen). 

2. NRT values (if set in the Clinical Details and Preferences screen Adjust tab). 

 Note: only NRT values greater than zero (those for which AutoNRT is measured) 
are shown. 

3. Current C levels of the electrodes. 

4. Current T levels of the electrodes, shown as green markers when adjustable and as 
grey markers when not currently adjustable in this screen. 

5. Currently selected band. 

Selection displays an electrode's C level and T level values, as well as the electrode 
number. 

6. Expected range of C levels, based on either the patient's AutoNRT results or the 
population average. 

7. Electrodes where C levels have been adjusted since the MAP was last saved. Other 
electrode C levels are altered by this adjustment. 
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Task steps: 

1. Open the Comfort screen. 

 Note: If the patient was on air before navigating to the Global Adjustments 
screen, they remain on air. If the patient was off air, they remain off air. 

2. If the patient is fitted with two cochlear implants, then click either Right or Left 

 to specify the implant for comfort adjustment. 

3. Click a Band and then click Sweep > or < Sweep to start a sweep to check for 
appropriate loudness in all bands. 

• To stop the sweep at any point, click Pause or the Esc key. 

• To continue the sweep after pausing, click Resume. 

• To restart the sweep after clicking Esc, click Sweep > or < Sweep. 

The patient should hear a 'beep' sound for each band in succession. 

If the patient does not report any sounds that are either uncomfortably loud or too 
quiet, and there are no signs of non-auditory stimulation, e.g. facial nerve 
stimulation, then no adjustments are required. 

 Note: To sweep individual electrodes instead of bands of three, click an electrode 
and then click Sweep > or < Sweep. This is useful to ensure complete electrode 
coverage for Freedom processors which sweep only one electrode per band. 

4. If the patient indicates sound is too loud or too soft, click the corresponding band 
button to stop the sweep. 

5. Adjust the loudness for the band. 

 Note: To adjust the C level for an individual electrode, click the electrode and use 
the arrow buttons to increase or decrease the C level. 

 Note: To change the size of adjustments, click in the Step size box below the 
buttons and either type a new value or use the keyboard  or  arrow keys to 
increase or decrease the value. 

 Tip: To reverse your C level adjustments, type Ctrl + Z or click Undo in the MAP 
menu. Restore them by typing Ctrl + Y or clicking Redo. 
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6. You can turn electrodes on and off from the comfort screen when the sound 

processor is  Off Air. 

To turn on or off an electrode: 

a. Right click on the electrode you want to turn on or off. 

b. Select Turn on/off electrode. 

c. Add a note to the electrode. 

d. Click Save and Close. 

Notes are visible when hovering over an off electrode. 

7. Perform another sweep to check for a comfortably loud sound level across all bands, 
and repeat the process if necessary. 

Your changes are saved when you select Save in the Finalise screen. 

Result: 

• The C levels are adjusted. 
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Thresholds 
Use the Thresholds screen to adjust the threshold measurements (T levels) for patients 
who have difficulty hearing the quietest sounds, or are hearing constant background 
noise. The threshold levels for five evenly distributed electrodes along the cochlear implant 
can be adjusted. 

Adjust each level so that it is just audible to the patient and then go on air to check the 
adjustment.  

When you access the Thresholds screen, the patient is initially on air and is able to hear 
you provide instructions. However, when you click any of the buttons on the Thresholds 
screen, the patient immediately goes off air. Ensure you provide the patient with 
instructions before making any adjustments. 

Threshold interpolation will only happen between measured channels. 

 Note: While in the Thresholds screen you can: 

•  Specify the size of the Up step or Down step adjustments. 

• Save the current MAP by clicking the Save option in the MAP menu. 

• Specify the current MAP's title and add explanatory text by clicking the MAP title 
and notes option in the MAP menu to bring up the Title and Notes window. 

• Click the  to: 

• Specify the number of stimulations (1 to 6). Asking the patient for the number 
of beeps they hear enables you to compare their answer with the number of 
stimulations actually made. 

• Set the NRT profile displayed as view only from the Select NRT levels screen 

using the NRTs, or NRTs button. 

• View a subset of the MAP parameters, or click Open or Open to display 
the Parameters window to view and modify a larger set of MAP parameters. 

Click off the  to close. 
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Key: 

1. Compliance limits for each electrode (if set in the Clinical details and preferences 
screen). 

2. NRT values (if set in the Clinical Details and Preferences screen Adjust tab). 

 Note: only NRT values greater than zero (those for which AutoNRT is measured) 
are shown. 

3. Currently selected electrode. 

Selection displays an electrode's C level and T level values, as well as the electrode 
number. 

4. Current C levels of the electrodes, shown in grey as they are not adjustable in the 
Thresholds screen. 

5. Electrodes where T levels have been adjusted since the MAP was last saved. Other 
electrode T levels are altered by this adjustment. 

6. Previous T levels of the electrodes. 

7. Current T levels of the electrodes. 

 Note: If enabled, a small blue dot is shown above electrodes previously measured in a 
saved MAP or a new MAP based on the saved MAP. Hovering over the dot will display the 
date and the MAP number of the measured electrode. 
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 Task steps: 

1. Open the Thresholds screen. 

The patient is on air and able to hear your instructions. 

2. If the patient is fitted with two cochlear implants, then click either Right or Left 

 to specify the implant for threshold adjustment. 

3. Change the number of beeps played if necessary, using Number of Stimulations in 

the . 

4. Click on each of the five thresholds (Very high, High, Mid, Low, and Very low): 

a. Ensure the patient is off air, then you can drag the chosen threshold's T level to 
a clearly audible point so that the patient can get a reference sound. 

b. Use the arrow buttons  to set the threshold to the minimum value 
where the patient can hear the beeps. 

• Click the right arrow  to play 'beep' sounds to the patient at the 
current level. 

• If the patient cannot hear the sound, click the up arrow . 

The level increases and beeps are played to the patient at the new level. 

 Note: To change the step size of the level increase, specify a new Up 
step value either by typing a value into the box, or by clicking in the box 
and using the keyboard up or down arrow keys to increase or decrease 
the value. 

• If the patient can easily hear the sound, click the down arrow  to 
decrease the level. 

 Note: To change the step size of the level decrease, specify a new 
Down step value either by typing a value into the box, or by clicking in 
the box and using the keyboard up or down arrow keys to increase or 
decrease the value. 

 Tip: To reverse your T level adjustments, type Ctrl + Z or click Undo in the 
MAP menu. Restore them by typing Ctrl + Y or clicking Redo. 
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5. Click the Off Air button to go on air. 

The patient is on air and able to hear your instructions. 

6. Check whether or not the level of soft sounds has improved for the patient, and 
repeat the process if necessary. 

Your changes are saved when you select Save in the Finalise screen. 

Result: 

• The thresholds are set to the minimum level at which the patient can still hear soft 
sounds. 

  

Use Fitting Assistant 
Fitting Assistant provides a knowledge base of commonly reported sound quality 
symptoms, together with recommended actions. 

Task steps: 

1. On any of the screens under Adjust, click the question mark icon to open the Fitting 
Assistant.  

2. Type a symptom in the Search box, or select an option in the list of symptoms. 

The Select an Action box displays a list of suggested actions. 

3. Select the desired action. 

The Details box indicates how the selected action changes the sound quality of the 
MAP and advises whether the change can be automatically applied by Custom Sound 
Pro software. 

4. Click Apply (where enabled). 

Changes are made to the MAP as detailed, and a counter appears alongside the 
selected action indicating the number of times the action has been applied. 

Where Apply is not enabled, the suggested action can be performed manually. 

5. To undo an action applied through Fitting Assistant, click the Undo button. 

Result: 

• The patient's MAP settings are modified as per the information provided by Fitting 
Assistant. 

Advanced Troubleshooting 
In some instances troubleshooting of the cochlear implant by use of the Advanced 
Telemetry Test may be required. Indicators for such troubleshooting include decreased 
performance or a failure to achieve the expected performance. Please contact your 
Cochlear representative if any of these indicators are present. 
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Set Levels 
Use the Set Levels screen to set threshold (T) and comfort (C) levels for the currently 
selected MAP, and to adjust MAP parameters as required. 

The Set Levels screen contains the following areas: 

• Set Levels toolbar: allows various actions and parameters to be applied to the 
currently selected MAP. 

• Programming tab: contains the controls used to set T and C levels and check battery 
suitability. The Expand  and Contract  arrows allow the various panels to be 
expanded or collapsed. 

• MAP Summary: contains information about the current MAP. Show details for 
parent MAP number, strategy, mode, rate, maxima and pulse width. 

For CI500 Series, CI422, Nucleus Hybrid, Freedom (CI24RE) and Nucleus 24 implants, 
if you exceed the compliance levels on one or more channels, a message displays to 
indicate that there are channels out of compliance. To bring the MAP into 
compliance, click Continue. The pulse width is changed across all electrodes and the 
T and C levels are reduced. Shift levels using the T & C option to adjust levels to 
achieve a comfortable loudness level for the recipient. Alternatively, click Ignore. The 
message is not displayed again during the session and the channels remain out of 
compliance. 

• Channel Grid: displays channels for each electrode along the array. Each active 
channel displays the following markers: 

•  C level 

•  T level 

•  NRT/objective level 

The markers can be adjusted by clicking and dragging them to the desired current 
level. 

Channels corresponding to turned off electrodes are automatically disabled and 
indicated by a symbol . Electrode Notes can be viewed by placing the cursor over 
the symbol. The channels on which high and low frequency tones are presented are 
indicated by a Bell symbol . 

The currently selected channel displays in gold in the Channel Grid on the Set Levels 
screen. Multiple channels can be selected by clicking the Channel Numbers, which 
remain highlighted until the channels are de-selected. The right-click menu displays 
a list of actions that can be applied to the selected channel or channels. 
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A narrow bar indicates T and C levels are automatically interpolated for that channel. 
Interpolation is only available in Monopolar stimulation modes and between 
channels that have the same pulse width. To make an interpolated channel 
measurable use one of the following options: 

• Click the Make All Channels Measurable button  on the Set Levels toolbar 
to access the entire array. 

• Highlight specific Channel Numbers in the Channel Grid and click the Make 

Only Selected Channels Measurable button  on the Set Levels toolbar. 
The non-selected channels are interpolated. 

• Double-click an interpolated channel in the Channel Grid to make it 
measurable (and vice-versa). 

• Data Grid: displays the parameters and values that apply to individual channels. The 
C level, T level and dynamic range values display by default, and additional 
parameters can be viewed by right-clicking on the Data Grid and selecting from the 
list of options. Values can be typed directly in the Data Grid cells or selected from 
drop-down lists. 

• Message box: displays information and warning messages relating to the current 
MAP. 

 Note: A message will be displayed if a MAP has one or more channels that exceed the 
limit for stimulation charge density. Some patients may need electrical stimulation levels 
above those known to be safe from the literature. The long term effects of such 
stimulation are unknown. Please call your Cochlear representative if you need further 
advice. 
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Configure live program settings 
Custom Sound Pro software allows you to adjust the volume, sensitivity and environment 
settings that apply to live voice testing. By default, Custom Sound Pro software sets the 
volume and sensitivity levels and other parameters such as ADRO® based on the 
environment that was last written to the sound processor. If more than one program is 
written to the sound processor, the settings are selected as follows: 

• For CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 
SE, CP1000 - Nucleus 7 and CP900 Series Sound Processors, the settings from the last 
used program are selected. If last used program can't be determined (coil-off 
condition etc) then the setting from the first used program are selected. If no 
previous program exists, the default program settings for the sound processor are 
used. 

• For CP800 Series and Freedom Sound Processors, if more than one Everyday 
environment exists, the settings from the first program are selected. If no Everyday 
environment exists, the settings from the Noise, Focus or Music environment are 
selected in that order. Where no previous environments exist, the default Everyday 
settings are selected. 

Task steps: 

1. Click the Configure Live Program Settings button  on the Set Levels toolbar. 

The Live Program Settings window displays. 

2. Drag the Volume slider to the desired value (0 to 9, or 1 to 10 for CP1110 - Nucleus 8, 
CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, 
CP900 Series and CP800 Series Sound Processors). 

  Notes: 

• The C levels that you see in the 'Set Levels' screen (i.e. what is shown on the 
screen) are always the C levels for a maximum volume setting (10). 

• When going live, at a conversational level of sound, the stimulation defaults to 
volume level 6 (i.e. those C levels you see on the screen are not reached). 

• When writing MAPs, the volume also defaults to 6 (unless it is changed). 
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3. Drag the Sensitivity slider to the desired value (0 to 20). 

The sensitivity level determines the minimum input signal level required for 
stimulation. A higher sensitivity setting requires a lower sound processor level to 
cause stimulation (and vice-versa). 

4. Enable or disable other live program parameters as appropriate. 

5. Click the Close button  to close the Live Program Settings window.  

The selected settings apply when you go live. The volume and sensitivity levels and 
the program configuration can be adjusted for individual programs in the Finalise 
screen (see Finalise). 

Result: 

• The live voice testing configuration parameters are set. 
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Select NRT/objective levels 
NRT or objective measurements obtained via Custom Sound Pro software, Nucleus 
SmartNav App or Custom Sound® EP software can be imported into the Adjustment and 
Set Levels screens and used as a guide for setting T and C levels. NRT/objective 
measurements must be selected in order to use an NRT/objective streamlined 
programming method. 

 Note: When changing the pulse width and then adjusting the T & C levels of a MAP 
created with previous NRT measurements, going live with the created MAP can result in 
the MAP sounding too loud, causing discomfort. It is important to include behavioural 
measures when using NRT markers. 

Task steps: 

1. Click Select NRT/Objective Levels or Import NRT/Objective Levels in the Method 
panel in Set Levels screens. 

Or, 

Click Create to create a new MAP and select Other measures option from the 
Create MAP based on menu in the Select MAP screen. 

The Select NRT/Objective Levels window displays. 

2. Select the type of measurement (for example, NRT) from the Measurement Type 
drop-down list. 

A list of available measurements displays, detailing the date of measurement and the 
electrodes measured. 

3. Select the measurements you want to use. 

Multiple measurements can be selected by holding down the Ctrl key and clicking 
the required measurements. 

4. Click OK. 

Result: 

• The NRT/objective levels for the measured channels display in the Channel Grid. 

 Note: 

• For Nucleus 24 implant types, a prompt displays when Import NRT/Objective Levels 
is selected. Click From Custom Sound EP to access the Select NRT/Objective Levels 
window; or, click From AGF File to open an externally saved .agf file from NRT 3.x. 

• For Nucleus 22 implants, NRT levels cannot be measured. The Method panel provides 
the option to Select Objective Levels only. 
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Use the behavioural method 
The behavioural method allows T and C levels to be set based on behavioural responses 
from the patient. T levels on the streamlined programming channels (by default, channels 
22, 16, 11, 6, and 1 where available) are measured using psychophysics and C levels are 
measured simultaneously using live voice testing. Where streamlined programming is 
supported, the behavioural method is selected by default when a new MAP is created. 

Task steps: 

1. Select the step sizes (1 to 10 CL) and the number of stimulations (1 to 999) in the 
Streamlined Programming panel. 

2. Click the Increase button  in the Set Ts area. 

The T level on the first streamlined channel increases by the step size indicated, and 
automatic stimulation occurs based on the number of stimulations specified. 

3. Continue to increase the T level until the threshold is reached. 

A smaller step size can be selected and the Decrease button  used as the 
threshold is neared. To manually stimulate a channel at any time, click the Stimulate 

button . 

4. Click each of the remaining streamlined channels in the Channel Grid in turn, and set 
the T level for each. 

The T levels for the non-measured channels are automatically interpolated. 

5. Click the Go Live button . 

6. Talk to the patient and click the Increase button  in the Live Cs area. 

The C levels increase globally by the step size indicated. 

7. Continue to adjust the C levels until ongoing conversational speech is comfortably 
loud. 

8. Click the Stop button  to stop live voice testing. 

Result: 

• T and C levels are set, based on behavioural responses from the patient. 

 Note: 

• The default channels for streamlined programming can be changed in the 
Streamlined tab of the Preferences window (F9). 

• The default parameters for setting T and C levels can be changed in the General tab 
of the Preferences window. 
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Use the NRT/objective offset method 
The NRT/objective offset method offsets the T level profile from the objective 
measurement profile, and enables a single offset channel to be measured using 
psychophysics. C levels are measured using live voice testing. 

Task steps: 

1. Click Change Programming Method in the Method panel. 

The Select Programming Method window displays. 

2. Click the NRT/Objective Offset option button, and click OK. 

If NRT/objective levels have not been selected, the Select NRT/Objective Levels 
window displays. Select the measurement type and the measurements you wish to 
use, and click OK. 

The T level on the offset channel (by default, channel 11 where available) is set to 80 
or 100 CL depending on the type of implant. The remaining T levels are interpolated 
to keep the difference between the starting T level and the objective measurement 
level equal to that of the offset channel. 

3. Select the offset channel in the Channel Grid. 

4. Select the step sizes (1 to 10 CL) and the number of stimulations (1 to 999) in the 
Streamlined Programming panel. 

5. Click the Increase button  in the Set Ts area. 

The T levels increase globally by the step size indicated, and automatic stimulation of 
the offset channel occurs based on the number of stimulations specified. 

6. Continue to increase the T levels until the threshold is reached. 

A smaller step size can be selected and the Decrease button  used as the 
threshold is neared. 

7. Click the Go Live button . 

8. Talk to the patient and click the Increase button  in the Live Cs area. 

The C levels increase globally by the step size indicated. 

9. Continue to adjust the C levels, watching for any indications that sound is too loud. 

10. Click the Stop button  to stop live voice testing. 

Result: 

• C and T levels are set using the NRT/objective method. 

 Note: The default T-offset channel can be changed in the Streamlined tab of the 
Preferences window (F9). 
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Measure individual channels 
When you do not want to use a streamlined programming method or streamlined 
programming is unavailable (for example, for ABI541, Nucleus 24 ABI or Nucleus 22 
implants), T and C levels can be measured on each individual channel. 

Task steps: 

1. Ensure the behavioural method is selected in the Streamlined Programming panel. 

2. Click the Make All Channels Measurable button  on the Set Levels toolbar to 
access the entire array (if required). 

3. Select the channel you want to measure in the Channel Grid. 

4. Click the C or T option button in the Set Ts and Cs panel based on which level you 
want to set. 

The T & C option button allows you to adjust the T and C levels for the selected 
channel simultaneously, keeping the dynamic range constant. 

5. Select the step sizes (1 to 10 CL) and the number of stimulations (1 to 999). 

6. Click the Increase  button. 

The T or C level on the selected channel increases by the step size indicated, and 
automatic stimulation occurs based on the number of stimulations specified. 

7. Continue to click the Increase  and Decrease  buttons until the desired level 
is reached, adjusting the step sizes as required. 
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8. If you do not want to measure every channel and the MAP supports interpolation, 
highlight the Channel Numbers that have been measured in the Channel Grid and 

click the Interpolate button . 

The T and/or C levels between the measured channels are automatically 
interpolated. 

 Note:  

• Interpolation is only available for MAPs created using Monopolar stimulation 
modes and between channels that have the same pulse width. 

• Interpolation is not available for ABI541 or Nucleus 24 ABI implants due to the 
variation in T and C levels from one electrode to the next. 

9. To test the T and C levels using live voice testing, click the Go Live button  on the 
Set Levels toolbar. 

Click the Stop All Stimulations button  on the Programming toolbar to stop live 
voice testing. 

 Note: The T & C option button allows you to adjust the T and C levels for the 
selected channel simultaneously, keeping the dynamic range constant 

Result: 

• T and C levels are measured on individual channels. 
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Set channel levels using the Sweep function 
The Sweep function allows the sequential stimulation of each active channel along the 
electrode array in order to check for channels that are too loud or too soft. Levels can be 
balanced by sweeping channels in small groups and confirming equal perception of 
loudness with the patient. 

Task steps: 

1. Click the C or T option button in the Sweep panel based on which levels you want to 
sweep. 

Alternatively, select a percentage from the drop-down list to sweep at a percentage 
of the dynamic range. 

2. Click the Selected option button and highlight the desired Channel Numbers in the 
Channel Grid. 

Alternatively, click the Channels option button and select a number of channels from 
the drop-down list. 

3. Select the number of sweep cycles you want to perform (1 to 20). 

4. Select the channel you want to start from in the Channel Grid, and click the Sweep 

Left  or Sweep Right  button. 

The specified channels are sequentially stimulated in the selected direction. 

 Note: To pause or stop the sweep at any time, click the Stop All Stimulations 

button  on the Programming toolbar. 

Result: 

• The channel levels are set using the Sweep function. 
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Set channel levels using the Shift function 
The Shift function allows selected T and/or C levels to be increased or decreased 
simultaneously. 

Task steps: 

1. Click the C, T or T & C option button in the Shift panel based on which levels you wish 
to shift. 

2. Click the CL option button to shift the levels by an absolute amount. 

Alternatively, click the % of DR option button to shift the levels by a percentage of 
the dynamic range for each channel. 

3. Click the All option button to shift the whole profile. 

Alternatively, click the Selected option button and highlight the desired Channel 
Numbers in the Channel Grid. 

4. Select the amount (1 to 10 CL) or the percentage (1 to 30 %) the levels are adjusted 
by. 

5. Click the Increase  or Decrease   button. 

Result: 

• The specified levels shift in the selected direction by the amount indicated. 

Set channel levels using the Tilt function 
The Tilt function allows the T and/or C level profile to be rotated left or right around a 
central channel. 

Task steps: 

1. Click the C, T or T & C option button in the Tilt panel based on which levels you wish 
to tilt. 

2. Select the amount the levels are adjusted by (1 to 10). 

3. Click the Tilt Left  or Tilt Right  button. 

Result: 

• The specified levels rotate in the selected direction by the amount indicated. 

 Note: By default, a non-linear tilt is enabled. To enable a linear tilt, access Tools > My 
Preferences, click the General tab and select Linear from the Tilt Profile Type drop-down 
list. 
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Modify channel gains 
In addition to the user-controlled microphone sensitivity that determines the overall gain 
applied to the input signal, each channel in a MAP includes an adjustable gain control. 
Channel gains can be modified during live voice testing to improve the perceived sound 
quality of a MAP. 

To modify individual channel gains using the Data Grid: 

Task steps: 

1. Right-click on the Data Grid and select Show Gain. 

The gain value displays for each channel. 

2. Click the desired cell and press the Down ( ) arrow key to select a value from the 
drop-down list. 

Result: 

• The gains of the specified channels are modified. 
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To modify global channel gains using the Gain Shapers window: 

Task steps: 

1. Click the Modify Gains button  on the Set Levels toolbar. 

The Gain Shapers window displays. 

2. Click the desired button in the Actions box: 

•  Increase low frequency gains only 

•  Increase low and high frequency gains 

•  Increase high frequency gains only 

•  Increase all frequency gains 

•  Centre all frequency gains 

•  Decrease all frequency gains 

•  Decrease low frequency gains only 

•  Decrease low and high frequency gains 

•  Decrease high frequency gains only 

The gain is applied to each channel output and affects the stimulation levels sent to 
the implant. 

To view the gain value of each channel in the Gain Shapers graph, select the Show 
Values check box. 

3. Click the Close button  to close the Gain Shapers window. 

Result: 

• The gains of the channels in the specified groups are modified. 

 Note: 

• For SPEAK, ACE and MP3000 strategies, channel gains are applied before the maxima 
are selected and can influence the channels selected for stimulation. Reducing the 
gain on a given channel de-emphasises that channel’s output, making it less likely to 
be selected. Conversely, increasing the gain emphasises the output. 

• For CIS strategies, all of the activated channels are stimulated during each frame, 
regardless of channel amplitude. Channel gains do not influence the channels 
selected for stimulation, but do increase or decrease stimulation levels. 
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Reorder channels 
Channels may need to be reordered when the tonotopic order of one or more channels is 
atypical. 

The tonotopic order of electrodes usually follows an orderly progression of pitch from high 
to low from base to apex. Channels that are not in the correct pitch order do not match up 
correctly with the frequency table used in the MAP, and can result in poor performance. 
Where channels are clearly out of pitch order and there are no electrode problems, the 
order of the channels can be changed.  

Channel reordering is particularly important for ABI541 and Nucleus 24 ABI implants as the 
pitch order is more complex with these devices. 

Task steps: 

1. Right-click on the Data Grid and select Show Active Electrode. 

2. Click the Make All Channels Measurable button  on the Set Levels toolbar to 
make all channels measurable (if required). 

3. Select the channel you wish to move, hold down the Ctrl key and drag the channel to 
the desired location. 

Result: 

• The Data Grid confirms the active electrode of the reordered channel is now 
stimulating the new channel location. The channel configuration of the adjacent 
channels change by one, and the affected Channel Numbers display in red. The 
psychophysical data of the reordered channel remains unchanged. 

 Note: Pitch order can be confirmed with the patient by sweeping the channels at C level 
after they have been balanced for loudness. See Set channel levels using the Sweep 
function. 
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Double channels 
Doubling a channel allocates two channels to the same electrode pair, and links the 
channels to ensure they keep the same T and C levels. 

Task steps: 

1. Right-click on the Data Grid and select Show Active Electrode. 

2. Click the Make All Channels Measurable button  on the Set Levels toolbar to 
access the entire array (if required). 

3. Highlight the Channel Numbers you wish to exclude from the MAP in the Channel 
Grid. 

4. Right-click on the Channel Grid and select Disable Selected Channels. 

5. Right-click on each channel you wish to double and select Double Channel (#). 

Result: 

• The selected channel doubles to the next basal channel, and the levels of the two 
channels are linked. Changes in the channel-to-electrode allocation are reflected in 
the Data Grid, and the affected Channel Numbers display in red. 
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Add notes and generate reports 
A title and additional notes can be added to a MAP, and a report of the MAP details can be 
generated and printed. 

To add a title and notes to a MAP: 

Task steps: 

1. Click the Title/Notes button  on the Set Levels toolbar. 

The Title and Notes window displays. 

2. Type a title for the MAP and any additional notes in the Title and Notes boxes. 

3. Click the Close button  to save the changes and close the Title and Notes window. 

Result: 

• The note is included in reports generated for the MAP. 

To generate a MAP report: 

Task steps: 

1. Click the Save MAP button  on the Set Levels toolbar to save the MAP (if 
required). 

2. Click the MAP Report button  on the Set Levels toolbar. 

3. Use the Print toolbar to print the MAP report. 

Result: 

• The Report viewer displays the details of the MAP, including sound processor and 
implant details, channel details and MAP parameters. This content is reproduced in 
the printed hard copy. 
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Predict T and C levels 
A saved MAP can be used to create an additional MAP with a different stimulation rate and 
pulse width, and the T and C levels can be predicted for the new MAP. The predict T and C 
levels function can only be used with Monopolar stimulation modes, and is not available 
for Nucleus 22 implants. 

Task steps: 

1. Open the initial saved MAP. 

2. Click the MAP Parameters button  on the Set Levels toolbar. 

The MAP Parameters window displays. 

3. Select a new value from the Channel Rate and/or Pulse Width drop-down lists. 

4. Click the Close button . 

The new MAP is created and the T and C levels are reset. 

5. Select a single channel in the Channel Grid (typically Channel 11) and measure the T 
and C levels. 

6. Click the Predict Levels button  on the Set Levels toolbar. 

Result: 

• Using the measured channel as a base, the shape of the T and C level profiles on the 
original MAP is applied to the new MAP on channels with the same stimulation mode 
and pulse width as the measured channel. 

For more information on measuring T and C levels, see Measure individual channels. 
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Create progressive MAPs 
After creating an initial MAP, additional MAPs can be created with the C levels 
automatically adjusted in each progressive MAP. 

Task steps: 

1. Open the initial MAP. 

2. Click the Create Progressive MAPs button  on the Set Levels toolbar. 

Result: 

• The initial MAP defaults to programming slot 1, and three additional MAPs are 
created for the remaining programming slots: 

• Programming slot 2: MAP 1 C levels + 5 CL 

• Programming slot 3: MAP 1 C levels + 10 CL 

• Programming slot 4: MAP 1 C levels - 5 CL 

 Note: 

• The default values by which the C levels are shifted can be changed in the Finalise 
tab of the Preferences window (F9). 
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Estimate compliance levels 
Once impedance measurements have been performed, Custom Sound Pro software allows 
you to view the voltage compliance level for each channel in a MAP. Where a channel is out 
of compliance, the maximum voltage available from the implant is not sufficient to 
generate the desired current level on that channel which may result in perceived loudness 
saturation or fluctuations. 

Compliance levels are automatically estimated when you do one of the following for the 
first time (or for the first time after changing the pulse width, stimulation mode or 
stimulation rate): 

• Go live with a MAP 

• Click a Battery icon  in the Battery Suitability box 

• Write a program to the sound processor 

If you see a message that compliance levels were not obtained, this may be due to implant 
communication issues. Check the coil alignment or replace the coil and re-estimate 
compliances. If required, contact your Cochlear representative for further assistance. 

Task steps: 

1. Ensure the coil is on the patient’s implant. 

2. Click the Estimate Compliance Levels button  on the Set Levels toolbar. 

Red markers display in the Channel Grid, indicating the compliance levels for the 
battery type selected in the Battery Suitability box. 

Note: If impedance measurements have not been performed, the red markers are 
not displayed. 

Where the C level on a channel exceeds the compliance level, the channel is deemed 
out of compliance and displays in red. 

3. To display the compliance levels for another battery type, click the corresponding 
check box in the Battery Suitability box. 

Result: 

• Compliance levels display for the selected battery type. 

 Note: 

• For ABI541 and Nucleus 24 ABI implants, compliance levels can only be estimated by 

clicking the Estimate Compliance Levels button . 

• Compliance levels cannot be estimated for Nucleus 22 implants. 

• If you wish compliance levels to be estimated by default when a MAP is first opened 
or created, access Tools > My Preferences, click the General tab and clear the Delay 
Auto Compliance Until Going Live check box. 
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Check battery suitability 
The Battery Suitability box displays the battery types applicable to the connected sound 
processor, and allows you to check which battery types are suitable for use with a MAP. A 
question mark next to a battery icon indicates battery suitability needs to be checked, and 
this information updates whenever the basic MAP parameters are changed. 

Task steps: 

1. Click a Battery icon  in the Battery Suitability box. 

Custom Sound Pro software performs the required measurements, and the 
Estimated Minimum Battery Life window displays the estimated hours for each 
battery type. Battery types that may not be suitable are highlighted in red or orange, 
and additional information displays in the Message box. Estimated hours are not 
available when the red marker is displayed. 

2. Click the Close button  to close the Estimated Minimum Battery Life window. 

Result: 

• The Battery Suitability box displays a green, orange or red marker for each battery 
type: 

•  Green: the battery type is suitable for use with the MAP. 

•  Orange: the battery type may result in sound degradation or sound 
processor cut-outs towards the end of battery life. 

•  Red: the battery type cannot deliver enough power for the MAP, which 
may result in unreliable operation or intermittency. 

Note: 

• For Nucleus 22 implants, you are prompted to confirm the patient’s coil is on the 
implant when you click a battery icon. Alternatively, if a skin flap measurement has 
not already been taken, you are prompted to estimate the skin flap thickness and 
optimise the power level. 
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Optimise the power level 
Power level optimisation helps ensure that all channels are in compliance and to maximise 
sound processor battery life. It works by characterising how much power is consumed by 
the implant under worst-case conditions. 

Custom Sound Pro software allows an automatic or manual power setting to be applied to 
a MAP. It is recommended Auto Power is used wherever possible, enabling the power level 
for the sound processor to be automatically optimised. 

The type of power setting currently selected displays in the Battery Suitability box (where 
available): 

•  Auto Power (default) 

•  Manual Power 

Once determined, the calculated power level displays in the MAP Parameters window, or 
can be viewed by placing the cursor over the power icon in the Battery Suitability box. 

The power level can be optimised for the following sound processors only: 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid and Freedom sound 
processors (excluding Nucleus 22 implants) 

Custom Sound Pro software automatically optimises the power level when you: 

• Click a Battery icon  in the Battery Suitability box 

• Write a program to the sound processor 

If the coil is not on the implant when power optimisation occurs, the power level is set to 
the previously saved level (where available) or the default level. 

 Note: When the power level is optimised, a stimulation occurs which may be heard by 
the patient. 
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CP900 Series and Freedom sound processors (Nucleus 22 implants) 

Custom Sound Pro software prompts you to measure the skin flap and optimise the power 
level when you first do one of the following: 

• Go live with a MAP 

• Click a Battery icon  in the Battery Suitability box 

• Write a program to the sound processor 

The calculated power level is used for all MAPs created or opened in the same 
programming session. 

To optimise the power level: 

Task steps: 

1. Ensure the coil is on the patient’s implant. 

2. Click the Measure Skin Flap and Optimise Power Level button  on the Set 
Levels toolbar. 

Alternatively, click Yes when the Auto Skin Flap Measurement prompt displays. 

Custom Sound Pro software measures the thickness of the skin flap and optimises 
the power level. The skin flap measurement displays in the Message box, and are 
included in the Session History report. 

Result: 

• Custom Sound Pro software measures the thickness of the skin flap and optimises 
the power level. The skin flap measurement displays in the Message box, and are 
included in the Session History report. 

• If you choose not to measure the skin flap, the power level is set to the previously 
saved level (where available) or the default level. 
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Apply a manual power level 
When it is not possible to use an automatic power setting, a manual power level can be 
applied to a MAP. 

Task steps: 

1. Click the MAP Parameters button  on the Set Levels toolbar. 

Alternatively, click the Power icon  in the Battery Suitability box. 

The MAP Parameters window displays. 

2. Click the Power level setting from the parameters list. 

3. Click the Manual option button and type a power level in the corresponding box. 

4. Click the Close button  to close the MAP Parameters window. 

Result: 

• The specified power level is applied to the MAP. 
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Finalise 
Use the Finalise screen to configure programs, apply listening environments, adjust 
processor settings, check battery suitability, and save the MAP to a sound processor. 

 Tip: The MAP number is shown in the bottom left corner of the program icons. 

 Note: When a new session is started, all MAPs on the sound processor will be opened 
and loaded into the appropriate slots on the Finalise screen. All existing program and 
processor settings on the sound processor will automatically be loaded and will appear in 
the relevant windows when these are displayed. 

1. Ensure the MAP that you want to save to the sound processor is selected. 

2. Configure programs for CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7 and CP900 Series Sound Processors: 

a. Click one of the program icons available in the Configuration area of the 

Finalise screen which may include SCAN  (SCAN 2 for CP1110 - Nucleus 8 

Sound Processors), or Program2 . 

The Programs screen displays. 

 Note: For bilateral patients with two CP1110 - Nucleus 8, CP1150 - Kanso 2, 
CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7 or CP900 
Series Sound Processors, or one of each, the Program screen displays the 
configuration data for the sound processors in a side by side layout, allowing 
you to view and edit both to ensure they are as similar as possible. 

b. Review the default settings and make any required changes. 

 Note: You can select a currently open MAP for use from the MAP drop-down 

list, or click the  icon to display the Select MAP window and choose from all 
available MAPs, enabling you to revert to previous MAPs easily. 

c. To add a new program, click the plus icon on an empty program slot and 
configure the programming settings as required. 

 Note: You can create progressive MAPs and their associated programs by 

clicking the  icon on the Programs screen. 

d. Click Save. 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 109 

3. Apply listening environments to MAPs for CP800 series and Freedom Sound 
Processors: 

a. Click one of the environment icons available in the Configuration area of the 

Finalise screen which may include Everyday , Noise , Focus  or 

Music  depending on the current processor type. 

The Environment Configuration screen displays. 

b. Review the default settings and make any required changes. 

 Tip: Click Defaults to reset the listening environment to the default settings. 

c. Click OK. 

4. Adjust processor settings CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, CP900 Series, and CP800 Series Sound 
Processors: 

a. Click Processor Settings. 

The Processor Settings screen displays. When the patient has two implants, the 
Processor Settings window displays the information for each in a side by side 
layout, allowing you to view and edit both to ensure they are as similar as 
possible. 

b. Review the processor settings and make any required changes. 

c. Click Save. 

d. Click Save to save any changes. 

 Tip: If you did not make any changes, click Cancel to close the Processor 
Settings window. 

5. Check battery suitability for powering the processor with the current MAP using 
battery estimation: 

a. Click Estimate battery now in the Battery Estimation box. 

b. Click on one of the battery symbols to display the Estimated Minimum Battery 
Life window with additional information. 

c. Click the Close button  to close the Estimated Minimum Battery Life window. 
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6. Click Save to write the programs to the sound processor. 

A  Save successful message appears when the configuration has been written to 
the sound processor and battery estimation is carried out for the sound processor if 
it has not been done already. 

7. Add session notes: 

a. Click the Today's Session Notes icon . 

The Today's Session Notes text area displays. 

b. Type session notes into the text area. 

c. Click the Today's Session Notes icon  again. 

The Today's Session Notes text area closes. 

8. Click Patient Report and print the report if you want to give to the patient a report 
to take home. 

Click Clinical Report and then print the report if you want to provide a report for 
other clinicians or for clinical records. 

9. Click End Session to end the fitting session. 

If any unsaved changes to MAPs are present, a save confirmation message appears. 
Click Yes to save MAP changes. 

The Patients screen displays, and the Session Details and Take Home reports display 
in separate tabs in the Report Viewer. 

10. Click the Close button  to close each of the reports in the Report Viewer. 
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Program settings 
Use the Programs screen to configure MAP, volume, and sensitivity variables for the 
current program for CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - 
Nucleus 7 SE, CP1000 - Nucleus 7 and CP900 Series Sound Processors. 

CP1110 - Nucleus 8 Sound Processors 

CP1110 - Nucleus 8 Sound Processors 

Program Settings Default setting 

SCAN 2 

 

Program 2 

 

MAP: sets the MAP for use. 

  Note: The drop-down list displays only currently open 
MAPs for selection. 

    

General 

Volume: sets the volume level. 6 6 

Sensitivity: sets the sensitivity level. 12 12 

SCAN 2: turns SCAN 2 on or off.     

SCAN 2 FF: enables the SCAN 2 program with automated 
ForwardFocus (SCAN 2 FF).  

SCAN 2 FF automatically manages ForwardFocus across 
different listening situations to help the user reduce 
distracting sounds occurring behind the patient. 

    

Icon: if Custom programming is being used, an icon can 
be selected for the Nucleus Smart App that is associated 
with the program. Either a numbered icon can be selected, 
or one of 10 icons depicting a scene are available. 

 Note: The choice of icon does not dictate the program 
type or place any restrictions on configuration. 
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Microphone Directionality 

Standard: Fixed and Adaptive microphone directionality 
are disabled. 

  

Fixed (zoom): enables the microphones to be focused in 
the forward direction. 

   

Adaptive (Beam): enables an adaptive beamformer 
designed to improve the signal-to-noise ratio of speech 
coming from one direction in a noisy environment. 

   

Audibility 

Boost soft sounds (ADRO): if selected, ADRO enables a 
digital pre-processing algorithm designed to make soft 
sounds more audible in quiet and maintain comfort for 
loud sounds. 

If custom programming is being used, the More 
(Whisper) check box is also available. Whisper™ enables a 
fast-acting compression scheme for improved access to 
soft and moderately loud sounds. This setting can be 
enabled if the Boost soft sounds (ADRO) check box is 
selected. 

  

Soften loud sounds (ASC): if selected, Autosensitivity 
Control is enabled.  

  

The Less (60dB) check box is available with SCAN 2 and 
Program 2 with the Autosensitivity Control breakpoint set 
to 60 decibels. This setting can be enabled if the Soften 
loud sounds (ASC) check box is selected. 

    

Noise Reduction 

Background (SNR-NR): enables automatic background 
noise reduction.  

  

Wind (WNR): enables automatic wind noise reduction. 
Comfort is improved when wind is automatically detected, 
by switching to a low noise microphone setting and 
suppressing loud channels.  

  

 Note: For CP1110 - Nucleus 8 Sound Processors, ADRO, Autosensitivity™, Whisper and 
SNR-NR apply to electric processing only, while Adaptive (Beam) and WNR apply to both 
electric and acoustic processing. 

  
 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 113 

CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 
Sound Processors 

CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 
Sound Processors 

Program Settings Default setting 

SCAN 

 

Program 2 

 

MAP: sets the MAP for use. 

  Note: The drop-down list displays only currently open 
MAPs for selection. 

    

General 

Volume: sets the volume level. 6 6 

Sensitivity: sets the sensitivity level. 12 12 

SCAN: turns SCAN on or off.     

Icon: if Custom programming is being used, an icon can 
be selected for the Nucleus Smart App that is associated 
with the program. Either a numbered icon can be selected, 
or one of 10 icons depicting a scene are available. 

 Note: The choice of icon does not dictate the program 
type or place any restrictions on configuration. 

   

Microphone Directionality 

Standard: Fixed and Adaptive microphone directionality 
are disabled. 

  

Fixed (zoom): enables the microphones to be focused in 
the forward direction. 

   

Adaptive (Beam): enables an adaptive beamformer 
designed to improve the signal-to-noise ratio of speech 
coming from one direction in a noisy environment. 
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Audibility 

Boost soft sounds (ADRO): if selected, ADRO enables a 
digital pre-processing algorithm designed to make soft 
sounds more audible in quiet and maintain comfort for 
loud sounds. 

If custom programming is being used, the More 
(Whisper) check box is also available. Whisper™ enables a 
fast-acting compression scheme for improved access to 
soft and moderately loud sounds. This setting can be 
enabled if the Boost soft sounds (ADRO) check box is 
selected. 

  

Soften loud sounds (ASC): if selected, Autosensitivity 
Control is enabled.  

  

The Less (60dB) check box is available with SCAN and 
Program 2 with the Autosensitivity Control breakpoint set 
to 60 decibels. This setting can be enabled if the Soften 
loud sounds (ASC) check box is selected. 

    

Noise Reduction 

Background (SNR-NR): enables automatic background 
noise reduction.  

  

Wind (WNR): enables automatic wind noise reduction. 
Comfort is improved when wind is automatically detected, 
by switching to a low noise microphone setting and 
suppressing loud channels.  

  

 Note: For CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 Sound 
Processors, ADRO, Autosensitivity™, Whisper and SNR-NR apply to electric processing 
only, while Adaptive (Beam) and WNR apply to both electric and acoustic processing. 
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CP900 Series Sound Processors 

CP900 Series Sound Processors 

Program Settings Default setting 

SCAN 

 

Program 2 

 

MAP: Sets the MAP for use.  Note: The drop-down list 
displays only currently open MAPs for selection. 

    

General 

Volume: sets the volume level. 6 6 

Sensitivity: sets the sensitivity level. 12 12 

SCAN: turns SCAN on or off.     

Icon: if Custom programming is being used, an icon can be 
selected for the Nucleus Smart App that is associated with the 
program. Either a numbered icon can be selected, or one of 
10 icons depicting a scene are available. 

 Note: The choice of icon does not dictate the program 
type or place any restrictions on configuration. 

   

Microphone Directionality 

Standard: Fixed and Adaptive microphone directionality are 
disabled. 

  

Fixed (zoom): enables the microphones to be focused in the 
forward direction. 

   

Adaptive (Beam®): enables an adaptive beamformer 
designed to improve the signal-to-noise ratio of speech 
coming from one direction in a noisy environment. 
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Audibility 

Boost soft sounds (ADRO): if selected, ADRO enables a 
digital pre-processing algorithm designed to make soft 
sounds more audible in quiet and maintain comfort for loud 
sounds. 

If custom programming is being used, the More (Whisper) 
check box is also available. Whisper™ enables a fast-acting 
compression scheme for improved access to soft and 
moderately loud sounds. This setting can be enabled if the 
Boost soft sounds (ADRO) check box is selected. 

  

Soften loud sounds (ASC): if selected, Autosensitivity Control 
is enabled.  

  

The Less (60dB) check box is available with SCAN and 
Program 2 with the Autosensitivity Control breakpoint set to 
60 decibels. This setting can be enabled if the Soften loud 
sounds (ASC) check box is selected. 

    

Noise Reduction 

Background (SNR-NR): enables automatic background noise 
reduction.  

  

Wind (WNR): enables automatic wind noise reduction. 
Comfort is improved when wind is automatically detected, by 
switching to a low noise microphone setting and suppressing 
loud channels.  

  

 Note: For CP900 Series Sound Processors, ADRO, Autosensitivity™, Whisper and SNR-
NR apply to electric processing only, while Adaptive (Beam) and WNR apply to both 
electric and acoustic processing. 
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Use the Environment Configuration screen to configure options for the current program 
with Freedom and CP800 Series Sound Processors. 

CP800 Series Sound Processors 

CP800 Series Sound Processors 

Program Settings Default setting 

  
    

    CP810 Sound 
Processors only 

MAP: sets the MAP for use.  Note: The drop-down list 
displays only currently open MAPs for selection. 

        

Volume: sets the volume level. 6 6 6 6 

Sensitivity: sets the sensitivity level. 12 12 12 12 

SmartSound options 

ADRO: enables a digital pre-processing algorithm 
designed to make soft sounds more audible in quiet 
and maintain comfort for loud sounds. 

    

Autosensitivity: enables the automatic adjustment of 
microphone sensitivity based on the noise floor of the 
surrounding environment. 

     

Zoom: enables the microphones to be focused in the 
forward direction. 

       

Beam: enables an adaptive beamformer designed to 
improve the signal-to-noise ratio of speech coming 
from one direction in a noisy environment. 

       

Whisper: enables a fast-acting compression scheme for 
improved access to soft and moderately loud sounds. 

       

None: enables SmartSound options to be disabled.         

Parameters 

Auto-sens. Brkpnt-SPL (dB): specifies the sound 
pressure level at which the Autosensitivity breakpoint is 
set. When the noise floor is above or below the 
breakpoint, the Autosensitivity control gradually 
reduces or increases the sensitivity respectively. 

57 
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Freedom Hybrid and Freedom Sound Processors 

Freedom Hybrid and Freedom sound processors 

Program Settings Default setting 

  
    

MAP: sets the MAP for use.  Note: The drop-down list 
displays only currently open MAPs for selection. 

        

Volume: sets the volume level. 6 6 6 6 

Sensitivity: sets the sensitivity level. 12 12 12 12 

SmartSound options 

ADRO: enables a digital pre-processing algorithm designed 
to make soft sounds more audible in quiet and maintain 
comfort for loud sounds. 

    

Autosensitivity: enables the automatic adjustment of 
microphone sensitivity based on the noise floor of the 
surrounding environment. 

      

Beam: enables an adaptive beamformer designed to 
improve the signal-to-noise ratio of speech coming from 
one direction in a noisy environment. 

       

Whisper: enables a fast-acting compression scheme for 
improved access to soft and moderately loud sounds. 

       

None: enables SmartSound options to be disabled.         

Note: For Freedom Hybrid sound processors, ADRO, Autosensitivity and Whisper apply 
to electric processing only, while Beam applies to both electric and acoustic processing. 

Parameters Adults Paediatrics 

Auto-sens. Brkpnt-SPL (dB): specifies the sound pressure 
level at which the Autosensitivity breakpoint is set. When 
the noise floor is above or below the breakpoint, the 
Autosensitivity control gradually reduces or increases the 
sensitivity respectively. 

57 57 

Telecoil Mixing: enables the sound processor to receive a 
mix of telecoil and microphone input. 

    

Telecoil Always On: enables the telecoil on the sound 
processor to be on at all times. 
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Sensitivity Mode: when Manual is selected, enables the 
sensitivity to be adjusted using the controls on the sound 
processor. When Fixed is selected, the sensitivity is applied 
at the level set in the Program box and cannot be adjusted 
by the patient. 

Manual Manual 

Volume Control: enables the volume to be adjusted using 
the controls on the sound processor. When cleared, the 
volume is applied at the level set in the Program box and 
cannot be adjusted by the patient. 

  

Accessory Mixing Ratio: specifies the ratio (1:1 to 10:1) of 
the accessory input in relation to the microphone input. 

2:1 1:1 

Telecoil Mixing Ratio: specifies the ratio (1:1 to 10:1) of the 
telecoil input in relation to the microphone input. 

3:1 1:1 

Tones and indicator lights Adults Paediatrics 

Private Tones: delivers a private tone when a warning is 
signalled. 

  

Private Key Press Notification: delivers a private tone 
when a key is pressed on the sound processor. 

  

Public Tones: delivers a public tone when a warning is 
signalled. 

   

Public Key Press Notification: delivers a public tone when 
a key is pressed on the sound processor. 

   

Indicator Light - Sound: displays a light on the sound 
processor to indicate an incoming audio signal is being 
received (Freedom sound processors only). 

   

Indicator Light - Key Presses and Alerts: displays a light 
on the sound processor when a warning is signalled or a 
key is pressed on the sound processor or remote assistant. 
The light is only applicable when the coil is on the implant.  
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Create progressive MAP programs 
From the Program screen, additional programs with MAPs can be created with the C levels 
automatically adjusted in each progressive MAP. 

Task steps: 

1. Select or create a program with the desired MAP. This will be the parent MAP. 

2. Click the Create Progressive MAPs button  . 

3. The Progressive MAPs screen will open. 

4.  The parent MAP defaults to programming slot 1. 

Use the arrows next to the values for the remaining program slot to set the shift to C 
level value based on patient needs. 

5. Click Continue. 

Result: 

• The parent MAP defaults to programming slot 1, and three additional progressive 
MAPs are created in the remaining programming slots based on the selected C level 
shift. 

 Note: 

• This is only available for CP900 Series Processor or later. 

• If a shifted C level will put the MAP out of compliance the MAP will not be created. 

• In most cases, the progressive MAP feature will create MAPs with increasing C-levels. 
If T levels have not been measured on the parent MAP used, then both T and C levels 
will be adjusted. 

• The default values by which the C levels are shifted can be changed in the Finalise 
tab of the Preferences window (F9). 
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Processor settings 
Use the Processor Settings window to adjust the way that CP1110 - Nucleus 8, CP1150 - 
Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, CP1000 - Nucleus 7, CP900 series, and 
CP800 Series Sound Processors work. You can use the Adult or Paediatrics defaults to 
provide a starting point for adjustments. 

When the patient has two implants, the Processor Settings window displays the 
information for each in a side by side layout, allowing you to view and edit both to ensure 
they are as similar as possible. 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and 
CP1000 - Nucleus 7 Sound Processors 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and 
CP1000 - Nucleus 7 Sound Processors 

Processor Configuration Default setting 

Adults Paediatrics 

Patient-Adjustable Settings 

Processor Controls: for CP1110 - Nucleus 8, CP1002 - 
Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 
Sound Processors, locks or enables the button on the sound 
processor. 

    

Telecoil Mixing Ratio: for CP1110 - Nucleus 8, CP1002 - 
Nucleus 7 S, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 
Sound Processors, specifies the ratio of the telecoil input in 
relation to the microphone input. 

3:1 1:1 

Accessory Mixing Ratio: specifies the ratio of the accessory 
input in relation to the microphone input. 

2:1 1:1 

Processor Lights: displays a light on the sound processor to 
indicate functionality or fault conditions. The options 
available in the list are: 

• Child - indicator lights are displayed for auxiliary input, 
alert states and program changes when the sound 
processor is on or off the head. 

• Adult - indicator lights are displayed for alert states or 
program changes when the sound processor is on or 
off the head. For auxiliary input, indicator lights are 
only displayed when the sound processor is off the 
head. 

Adult Child 

Processor Beeps (Private Tones): delivers a private tone 
when a warning is signalled or a key is pressed on the sound 
processor or remote control. 
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Clinician-Adjustable Settings 

Allow user controlled ForwardFocus: (not available for 
CP1002 - Nucleus 7 S and CP1001 - Nucleus 7 SE Sound 
Processors) enables reduction of noise occurring behind the 
patient. When selected, ForwardFocus can be turned on or 
off by the patient using the Nucleus Smart App.  

    

Allow Telecoil: for CP1110 - Nucleus 8, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 Sound 
Processors, enables the telecoil to be activated on the sound 
processor. When selected, Telecoil can be turned on or off 
by the patient using the sound processor or the remote 
control or Nucleus Smart App. 

    

Auto Processor Off: enables the sound processor to turn 
off automatically when the coil is off the implant for more 
than two minutes. 

  
 

 *CP1150 - Kanso 
2 only 

Soft MAP Start Duration: specifies the sound processor 
start up duration to ramp up the volume from a soft level to 
the final level set in the MAP. If a patient experiences sound 
processor start up noise, using a value greater than 0 
seconds may minimise this noise. 

0 seconds 0 seconds 

mySmartSound Settings 

Allow Volume Control: enables the volume to be adjusted 
using the controls on the remote control or the Nucleus 
Smart App. When cleared, the volume is applied at the level 
set in the Program box and cannot be adjusted by the 
remote control or the Nucleus Smart App. 

  

Allow Sensitivity Control: enables the sensitivity to be 
adjusted using the controls on the remote control or the 
Nucleus Smart App. When cleared, the sensitivity is applied 
at the level set in the Program box and cannot be adjusted 
using the remote control or the Nucleus Smart App. If 
selected, the Loudness Control Preference check box 
becomes enabled. 

    

Loudness Control Preference: specifies the loudness 
control option for the remote control if the Allow Volume 
Control and Allow Sensitivity Control options are selected. 
Available options are Volume or Sensitivity. 

Volume Volume 

Allow Master Volume Limit Control: enables the user to 
make adjustments to the Master Volume control settings 
from the Nucleus Smart App.  
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Limit: enables MV Limit to be set to plus or minus 10 CL or 
to Unlimited. This list is only visible if the Allow Master 
Volume Limit Control option is selected. 

10 CL 10 CL 

Allow Bass and Treble Control: enables Bass and Treble 
settings to be adjusted using the Nucleus Smart App. When 
cleared, no adjustments are possible. The limit is plus or 
minus 6 CL. 

    

 Smart bimodal streaming hearing aid 

Link smart bimodal streaming hearing aid: allows linking 
of a patient's compatible smart bimodal streaming hearing 
aid with their CP1110 - Nucleus 8, CP1001 - Nucleus 7 SE or 
CP1000 - Nucleus 7 Sound Processor. Any smart bimodal 
streaming hearing aids that are linked to the patient's 
CP1110 - Nucleus 8, CP1001 - Nucleus 7 SE or CP1000 - 
Nucleus 7 Sound Processor are listed. If a patient upgrades 
their smart bimodal streaming hearing aid, the link between 
the hearing aid and sound processor can be updated. This 
option is not available for bilateral patients. 
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CP900 Series Sound Processors 

CP900 Series Sound Processors 

Processor Configuration Default setting 

Adults Paediatrics 

Patient-Adjustable Settings 

Processor Controls: locks the buttons on the sound 
processor. 

    

Telecoil Mixing Ratio: specifies the ratio of the telecoil 
input in relation to the microphone input. 

3:1 1:1 

Accessory Mixing Ratio: specifies the ratio of the accessory 
input in relation to the microphone input. 

2:1 1:1 

Processor Lights: displays a light on the sound processor to 
indicate functionality or fault conditions. The options 
available in the list are: 

• Child - indicator lights are displayed for microphone 
input, auxiliary input, alarms and processor auto-off 
when the sound processor is on or off the patient's 
head. 

• Monitor - indicator lights are displayed for auxiliary 
input when the sound processor is off the patient's 
head, alarms and processor auto-off. 

• Adult - indicator lights are displayed for alarms when 
the sound processor is off the patient's head and 
processor auto-off. 

Monitor Child 

Processor Beeps (Private Tones): delivers a private tone 
when a warning is signalled or a key is pressed on the sound 
processor or remote assistant. 
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Clinician-Adjustable Settings 

Allow Telecoil: enables the telecoil to be activated on the 
sound processor. When selected, Telecoil can be turned on 
or off by the patient using the sound processor or the 
remote assistant. 

 Note: For CP950 - Kanso Sound Processors, Allow Telecoil 
is not selected by default, and is unavailable when the total 
stimulation rate (TSR) is under 7200 Hz. 

 Note: For CP950 - Kanso Sound Processors with CI600 
series implants, the Allow Telecoil option is not available. 

  

Allow Auto Telecoil: enables the sound processor to 
automatically activate the telecoil in response to an 
incoming signal. When selected, Auto Telecoil can be turned 
on or off by the patient using the remote assistant. Allow 
Telecoil must be selected to allow Auto Telecoil to be 
enabled. 

 Note: This feature is not supported with the CP950 - 
Kanso Sound Processor. 

   

Auto Processor Off: enables the sound processor to turn 
off automatically when the coil is off the implant for more 
than two minutes. 

 Note: For Nucleus 22 implants, this setting is not 
available. 

   

Processor Interface: specifies the user interface option for 
the sound processor. When Simple is selected, volume and 
sensitivity cannot be adjusted using the controls on the 
sound processor. When Advanced (Volume) or Advanced 
(Sensitivity) is selected, volume or sensitivity respectively 
can be adjusted via the sound processor in addition to the 
remote assistant. 

Simple Simple 

Soft MAP Start Duration: specifies the sound processor 
start up duration to ramp up the volume from a soft level to 
the final level set in the MAP. If a patient experiences sound 
processor start up noise, using a value greater than 0 
seconds may minimise this noise. 

0 seconds 0 seconds 
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Patient Hearing Adjustments 

Allow Volume Control: enables the volume to be adjusted 
using the controls on the remote assistant. When cleared, 
the volume is applied at the level set in the Program box 
and cannot be adjusted by the remote assistant. 

  

Allow Sensitivity Control: enables the sensitivity to be 
adjusted using the controls on the remote assistant. When 
cleared, the sensitivity is applied at the level set in the 
Program box and cannot be adjusted using the remote 
assistant. If selected, the Loudness Control Preference check 
box becomes enabled. 

    

Loudness Control Preference: specifies the loudness 
control option for the remote assistant if the Allow Volume 
Control and Allow Sensitivity Control options are selected. 
Available options are Volume or Sensitivity. 

Volume Volume 

Allow Master Volume Control: enables the user to make 
adjustments to the Master Volume settings from a remote 
assistant.  

    

Master Volume Limit: enables MV Limit to be set to plus or 
minus 10 CL or to Unlimited. This list is only visible if the 
Allow Master Volume Control option is selected. 

10 CL 10 CL 

Allow Bass & Treble Control: enables Bass and Treble 
settings to be adjusted using the controls on the remote 
assistant. When cleared, no adjustments are possible. The 
limit is plus or minus 6 CL. 
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CP800 Series Sound Processors 

CP800 Series Sound Processors 

Processor Configuration Default setting 

  Adults Paediatrics 

Patient-Adjustable Settings 

Processor Button Lock: locks the buttons on the sound 
processor. 

    

Telecoil Mixing Ratio: specifies the ratio of the telecoil 
input in relation to the microphone input (CP810 Sound 
Processors only). 

3:1 1:1 

Accessory Mixing Ratio: specifies the ratio of the 
accessory input in relation to the microphone input 
(CP810 Sound Processors only). 

2:1 1:1 

Indicator Light - Sound: displays a light on the sound 
processor to indicate an incoming audio signal is being 
received. 

   

Indicator Light - Key Presses and Alerts: displays a 
light on the sound processor when a warning is 
signalled or a key is pressed on the sound processor or 
remote assistant. The light is only applicable when the 
coil is on the implant.  

   

Processor Beeps (Private Tones): delivers a private 
tone when a warning is signalled or a key is pressed on 
the sound processor or remote assistant.  

  

 
 Note: Patients can change the patient-adjustable parameters at any time using the 
remote assistant. 
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Clinician-Adjustable Settings 

Allow Telecoil: enables the telecoil to be activated on 
the sound processor. When selected, Telecoil can be 
turned on or off by the patient using the sound 
processor or the remote assistant (CP810 Sound 
Processors only). 

  

Allow Auto Telecoil: enables the sound processor to 
automatically activate the telecoil in response to an 
incoming signal. When selected, Auto Telecoil can be 
turned on or off by the patient using the remote 
assistant. Allow Telecoil must be selected to allow Auto 
Telecoil to be enabled (CP810 Sound Processors only). 

   

Auto Processor Off: enables the sound processor to 
turn off automatically when the coil is off the implant 
for more than two minutes. 

   

Processor Interface: specifies the user interface option 
for the sound processor. When Simple is selected, 
volume and sensitivity cannot be adjusted using the 
controls on the sound processor. When Advanced 
(Volume) or Advanced (Sensitivity) is selected, volume 
or sensitivity respectively can be adjusted via the sound 
processor in addition to the remote assistant. 

Simple Simple 

Patient Hearing Adjustments 

Allow Volume Control: enables the volume to be 
adjusted using the controls on the remote assistant. 
When cleared, the volume is applied at the level set in 
the Program box and cannot be adjusted by the remote 
assistant. 

  

Allow Sensitivity Control: enables the sensitivity to be 
adjusted using the controls on the remote assistant. 
When cleared, the sensitivity is applied at the level set in 
the Program box and cannot be adjusted using the 
remote assistant. 

  

Allow Hearing Profile Adjustments: enables the 
patient to use Remote Assistant Fitting to adjust a MAP 
created by their clinician using Custom Sound Pro 
software. The MAP must meet criteria to be adjusted via 
Remote Assistant Fitting. 

    

Allow Creation of New Hearing Profile: enables the 
patient to use Remote Assistant Fitting to create a 
brand new MAP using their remote assistant if the 
Allow Hearing Profile Adjustments option is selected. 
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Estimate battery 
Battery Estimation allows you to check which battery types are suitable for use with a MAP. 
Battery Estimation takes place automatically when writing to a sound processor and can 
also be initiated using the Estimate battery now button. For CP1150 - Kanso 2 Sound 
Processors the battery health can also be checked. The battery health check indicates if the 
battery in the CP1150 can be charged or if it needs to be replaced. 

The battery types may include: 

 
 2 Zinc Air, 2 Nucleus Zinc Air 

 
3 Zinc Air 

 
 Compact Rechargeable, Nucleus 
Compact 

 
Lithium ion 

 
Standard Rechargeable, Nucleus 
Power Extend 

 
2 AAA 
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Task steps: 

1. Click Estimate battery now in the Battery Estimation box. 

Custom Sound Pro software performs the required measurements. The Battery 
suitability box displays, showing a green, orange, red, or blue marker for each 
battery type, and the estimated number of hours from fully charged to fully 
depleted: 

•  Green: the battery type is suitable for use with the MAP. 

•  Orange: the battery type may result in sound degradation or sound 
processor cut-outs towards the end of battery life. 

•  Red: the battery type cannot deliver enough power for the MAP, which 
may result in unreliable operation or intermittency. 

•  Blue: the battery type has not been checked. 

Battery types that may not be suitable are highlighted in red or orange, and 
additional information displays in the Message box. Estimated hours are not 
available when a red or blue marker is displayed. 

2. Click on one of the battery symbols to display the Estimated Minimum Battery Life 
window with additional information. 

3. Click the Close button  to close the Estimated Minimum Battery Life window. 

Result: 

• The Battery suitability box displays a green, orange, red, or blue marker for each 
battery type, and the estimated number of hours from fully charged to fully 
depleted. 

 Note: 

• For Nucleus 22 implants, you are prompted to confirm the patient’s coil is on the 
implant when you click a battery icon. Alternatively, if a skin flap measurement has 
not already been taken, you are prompted to estimate the skin flap thickness and 
optimise the power level. 

Estimated Minimum Battery Life 
Displays the current MAP and auto power setting for each Program, as well as the 
estimated number of hours that various battery types can be expected to last when 
powering a sound processor with the specified settings. 
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Link smart bimodal streaming devices for bimodal 
patients 
For patients with a cochlear implant on one side and a hearing aid on the other side, their 
smart bimodal streaming devices (CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1001 - Nucleus 
7 SE or CP1000 - Nucleus 7 Sound Processor and a compatible smart bimodal streaming 
hearing aid) can be linked. Linked smart bimodal streaming devices can be simultaneously 
paired to an iPhone, iPad, iPod touch or compatible Android devices. 

The smart bimodal streaming devices become linked when the ID of each device is written 
to the other during a fitting session. 

During a fitting session, the steps to link smart bimodal streaming devices are: 

1. Ask the patient to turn off Bluetooth on their compatible device if they have already 
paired their smart bimodal streaming hearing aid with the device. 

2. Connect the Noahlink Wireless programming interface. 

3. Ensure that any software using the Noahlink Wireless device is closed. 

4. On the Processor Configuration window, click Link. 

5. Put the smart bimodal streaming hearing aid into pairing mode. 

6. Identify the patient's hearing aid. 

7. Link the smart bimodal streaming devices. 

Hearing aid not connecting? 

If the patient's hearing aid cannot be found check that: 

• The hearing aid is in pairing mode so that Noahlink Wireless can discover the hearing 
aid. To put the hearing aid in pairing mode either: 

• Open and then close the battery door 

• If there is no battery door, press the button for 5 seconds to switch off the 
hearing aid then press the button for 5 seconds to switch on the hearing aid. In 
some hearing aids, an LED lights up when the hearing aid turns on, and flashes 
three times when the hearing aid turns off. 

• The battery in the hearing aid has sufficient charge. 

• The patient's device has Bluetooth turned off. 

If the patient has already paired their smart bimodal hearing aid with their 
compatible device, Noahlink Wireless cannot discover the hearing aid if Bluetooth is 
turned on. 
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Don't see the hearing aid you're looking for? 

Not all smart bimodal streaming hearing aids can be linked with a CP1110 - Nucleus 8, 
CP1150 - Kanso 2, CP1001 - Nucleus 7 SE or CP1000 - Nucleus 7 Sound Processor. If the 
patient's hearing aid does not appear in the Linking Hearing Devices screen, or if it 
appears but cannot be selected, it may not be a compatible hearing aid. To see the list of 
specific compatible hearing aids, go to the following location: 

www.cochlear.com/nucleus/compatibility 

If the patient has a compatible hearing aid that does not appear, try to link the sound 
processor and hearing aid again. 
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Shutting down 
To shut down Custom Sound Pro software: 

1. Select File > Exit from the top menu. 

If you have an open patient with changes to new or opened MAPs, you will be given 
the option to: 

• Save the MAPs and exit, 

• Don't save any changes and exit or  

• Cancel. 

Result: 

•  The Custom Sound Pro software application will close.  
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My clinic 
Use the My clinic functionality to edit the current clinic's details, edit the information of 
existing clinicians, and create new clinician entries. 

Set clinician preferences 
You can set your own default preferences without the need for administrator permission. 
These preferences control certain Custom Sound Pro software behaviour when you log in. 

Task steps: 

1. Click on Tools > My preferences in the Menu bar. 

The Clinician Details and Preferences window displays with the Personal tab 
selected. 

2. Click each tab in turn and select the desired settings (see the table in the Clinician 
Details and Preferences window topic). 

3. Click Save to save the changes and close the Clinician Details and Preferences 
window. 

 Note: The Save button is available only if changes have been made to the 
clinician preferences. 

Result: 

• The clinician preferences are updated. 
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Create a clinician 
The username entered when the Custom Sound Pro software database is installed is 
automatically created as a clinician with clinic administrator rights. Users with clinic 
administrator rights can create additional clinicians and edit preferences for all clinicians 
as required. Creating individual users allows each clinician to set their own preferences. 
The patient database is shared across all users. 

Task steps: 

1. Click on Tools > My Clinic in the Menu bar. 

2. Click the Create New Clinician link. 

The Clinician Details and Preferences window displays with the Personal tab 
selected. 

3. Type the clinician’s name in the Username box. 

This box is mandatory. 

4. Type the clinician's email address in the Email box. 

The email address box is optional but automatically populates the Feedback form 
when providing feedback about Custom Sound Pro software to Cochlear. 

5. To give the clinician administrator rights, select the Clinic Administrator check box. 

Users with administrator rights can add or edit other clinicians. 

6. To set a password for the clinician, click Set Password, type the password details and 
click OK. 

7. To set additional preferences for the clinician, click each of the tabs in the Clinician 
Details and Preferences window and select the desired settings. 

Clinicians can set their own preferences at any time. 

8. Click Save to save the changes and close the Clinician Details and Preferences 
window. 

The clinician displays in the Registered Clinicians list. 

9. Create additional clinicians as desired, or click the Close button  to close the Clinic 
window. 

Result: 

• The new clinician ID is ready for use. 

 Note: If Quick/Standard Programming has been installed as a regional option, Quick 
Programming or Standard Programming can be selected in the Personal tab of the 
Preferences window. Standard programming provides access to all clinical features in 
Custom Sound Pro software, while quick programming provides access to the most used 
clinical features only. 
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Edit selected clinician 
If you have clinic administrator permission, you can edit the details for other clinicians that 
have been registered in Custom Sound Pro software. These preferences control certain 
Custom Sound Pro software behaviour when you log in. 

Task steps: 

1. Click on Tools > My clinic in the Menu bar. 

The My Clinic window displays a list of registered clinicians. 

2.  Select a clinician to edit from the list. 

3. Click the Edit Selected Clinician link from Select a task.  

The Clinician Details and Preferences window displays with the Personal tab 
selected. 

4. Click each tab in turn and select the desired settings (see the table in the Clinician 
Details and Preferences window topic). 

5. Click Save to save the changes and close the Clinician Details and Preferences 
window. 

 Note: The Save button is available only if changes have been made to the 
clinician preferences. 

Result: 

• The selected clinician preferences are updated. 

Edit clinic details 
If you have clinic administrator permission, you can edit clinic details. 

Task steps: 

1. Click on Tools > My Clinic in the Menu bar. 

The My Clinic window displays a list of registered clinicians. 

2. Click the Edit Clinic Details link from Select a task. 

The Clinic Details window General tab displays. 

3. From this tab you can edit the Clinic Name, Cochlear ID and Processor diagnostics 
options. 

 Note: The Processor diagnostics field will only be show if the 'CREM Data 
Logger' function has been enabled under regional options. 

The OK button becomes active as soon as a change has been made. 

4. Click OK to save the changes and close the Clinic Details window. 

Result: 

• The clinic details are modified. 
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Manage auto-updates 
If you have clinic administrator permission, you can manage the auto-update preferences 
for Custom Sound Pro software. 

Task steps: 

1. Click on Tools > My Clinic in the Menu bar. 

The My Clinic window displays a list of registered clinicians. 

2. Click the Edit Clinic Details link. 

The Clinic Details window General tab displays. 

3.  Select the Auto Update tab.  

4. Select one of the auto-update options from the Preferences. 

• Automatically download but ask me to install update on application close. 

• Notify me of updates. I will choose when to download and install the update. 

• Do not download or install update. 

The OK button becomes active as soon as a change has been made. 

5. Click OK to save the changes and close the Clinic Details window. 

Result: 

• The auto-update preferences are modified. 
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Set or change clinician's login password 
Set a password to prevent unauthorised access and change that password when 
necessary. 

Task steps: 

1. Click on Tools > My preferences in the Menu bar. 

The Clinician Details and Preferences window displays with the Personal tab 
selected. 

2. Click Set Password. 

The Set Password window displays. 

3. To set the password: 

a. Type a password into the Password box. 

b. Type the same password into the Confirm Password box. 

4. To change the password: 

a. Delete the contents of both the Password and Confirm Password boxes. 

b. Type a password into the Password box. 

c. Type the same password into the Confirm Password box. 

5. Click OK. 

 Note: The password cannot be set or changed unless The Password and Confirm 
Password boxes have identical contents. If they do not, a message appears 
indicating this issue. 

Result: 

• The clinician password is set or changed. 
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Clinician Details and Preferences 
Use the Clinician Details and Preferences screen to set individual clinician Custom Sound 
Pro software preferences. 

The following settings can be selected from the tabs in the Preferences window: 

Personal 

Username Contains the user name of the clinician. 

Email Contains the email address of the clinician. This entry 
automatically populates the Feedback form when 
providing feedback about Custom Sound Pro software to 
Cochlear. 

Cochlear ID Contains the Cochlear ID of the clinician.  

This account is disabled If you have administrator permission, select this box to 
disable a clinician account that you are creating or 
updating. Clear the box to enable the clinician account. 

Clinic administrator If you have administrator permission, select this box to 
grant administrator privileges when creating or modifying 
a clinician account. Clear the box to remove administrator 
privileges. 

Mute PC audio All PC audio output from Custom Sound Pro software will 
be muted.  

Help improve Custom Sound 
by automatically sending de-
identified usage statistics to 
Cochlear 

Select this box to permit Custom Sound Pro software to 
send usage statistics to Cochlear. Clear the box to revoke 
permission to send the usage statistics. 

Automatically send error 
reports to Cochlear 

Select this box to permit Custom Sound Pro software to 
automatically send error reports to Cochlear. These 
reports include clinic, clinician name, clinician email, de-
identified patient .cdx file and error details, for the 
purpose of resolving the error. Clear the box to revoke 
permission to automatically send the error report. 

Set password Access the Set Password window to set or update the 
clinician's password. 

Patient List 

Display items Specify the items for display in the Patient List screen by 
checking them in this tab. Cleared items will not be shown. 
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New MAPs 

Children Specifies the eldest age that patients are considered as 
children.  

Sets the default settings when you create new MAPs for 
children, such as program strategy, stimulation rate and 
maxima. 

If you select new MAPs to be based on thresholds, when 
you create a new patient, after impedances are measured, 
the next step is to measure thresholds. 

If you select new MAPs to be based on Population Mean, 
when you create a new patient, the next step is to adjust 
the master volume from Global Adjustments. 

If you select new MAPs to be based on AutoNRT, when you 
create a new patient, after AutoNRT, the next step is to 
adjust the master volume from Global Adjustments. 

Adults and older children Indicates the age at which patients are considered as 
older children and adults based on the age specified for 
children. 

Sets the default settings when you create new MAPs for 
adults and older children, such as program strategy, 
stimulation rate and maxima. 

If you select new MAPs to be based on thresholds, when 
you create a new patient, after impedances are measured, 
the next step is to measure thresholds.  

If you select new MAPs to be based on Population Mean, 
when you create a new patient, the next step is to adjust 
the master volume from Global Adjustments. 

If you select new MAPs to be based on AutoNRT, when you 
create a new patient, after AutoNRT, the next step is to 
adjust the master volume from Global Adjustments. 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 141 

AutoNRT 

General Number of electrodes: the specified number of 
electrodes is selected by default when performing 
AutoNRT measurements. 

Display Show traces during AutoNRT: the NRT Traces window 
displays automatically when performing AutoNRT. 

Show NRT/objective markers: NRT/objective level 
markers display in the Channel Grid. 

Intraoperative Options Perform electrode conditioning: electrodes are 
conditioned at the specified current level prior to 
measuring the NRT level. 

Electrode conditioning current level: electrodes are 
conditioned at the specified current level prior to 
measuring the NRT level. 

Perform enhanced interpolation: automatic 
interpolation of NRT levels is enabled. 

Post-operative Options Starting current level: each channel starts measuring the 
NRT level from the specified current level. 

Auto increase waiting time: the AutoNRT algorithm 
waits the specified amount of time before increasing the 
stimulus required to perform the next measurement. 
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Adjust 

Global Adjustments Step size: specifies the default size of adjustments of T 
and C levels on the Global Adjustments screen. 

Comfort Step size: specifies the default size of adjustments of T 
and C levels on the Comfort screen. 

Thresholds Up step size: specifies the default size of the increase in T 
levels on the Thresholds screen. 

Down step size: specifies the default size of the decrease 
in T levels on the Thresholds screen. 

Display Show electrode numbers: displays the corresponding 
electrode number below each electrode on the graphs of 
the Global Adjustments, Comfort, and Threshold screens. 

Show compliance limits: displays the compliance limit of 
each electrode on the graphs of the Global, Comfort, and 
Threshold screens. 

Show NRT values: displays the NRT value for those 
electrodes that have been measured on the graphs of the 
Global Adjustments, Comfort, and Threshold screens. 

Show previously measured electrodes in Thresholds: 
displays those electrodes from a saved MAP or a new MAP 
based on a saved MAP, that have been measured on the 
Threshold screens in a previous session. A blue dot shows 
measured electrodes. Hovering over the dot will display 
the date and the MAP number of the measured electrode. 

Use in touch mode: changes the controls on the Adjust 
screens so that they are optimised for use on tablets. 
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Set Levels 

Levels Up step size: specifies the default size of the increase in a 
T or C level that results from clicking the keyboard Up 
arrow. 

Down step size: specifies the default size of the decrease 
in a T or C level that results from clicking the keyboard 
Down arrow. 

Number of sweep cycles: specifies the default number of 
sweep cycles. 

Global Modifier Shift step size: specifies the default size of the increase or 
decrease of the selected T and / or C levels. 

Shift mode: specifies whether the default will be to shift 
levels by an absolute amount, or by a percentage of the 
dynamic range for each channel. 

Tilt value: specifies the default value by which the 
selected levels will be adjusted when rotated left or right 
around a central channel. 

Tilt profile type: specifies whether the tilt will be linear or 
non-linear by default. 

Stimulations Number of stimulations: specifies the number of beeps 
played to the patient. 

Stimulation duration (ms): specifies the length of time 
that each beep lasts. 

Inter-stimulus duration (ms): specifies the length of 
time between each beep. 

Auto-stimulate: enables auto stimulation when setting T 
and C levels. 

MAP Display Show parent MAP levels: when creating a new MAP 
based on a saved MAP, markers display in the Channel 
Grid indicating the original T and C levels. 

Show levels as tooltip hint: when the cursor is placed 
over a channel in the Channel Grid, the T and C level 
values display as a tooltip. 

Show levels on channel marker labels: the T and C level 
values of each selected channel display in the Channel 
Grid. 
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Data Grid Advanced Properties The selected options display in the Data Grid on the Set 
Levels screen. 

Streamlined Default Channels Behavioural channels: the selected channels display as 
measurable when using the Behavioural method. 

T-offset channels: the selected channel displays as 
measurable when using the NRT/objective offset method. 

Finalise 

Progressive MAPs When creating progressive MAPs, the C level profile on 
each additional MAP is adjusted by the specified amount. 

Processor Settings Age Default Specifies the eldest age that patients are considered as 
children for whether the paediatric processor settings are 
used by default.  
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Provide feedback 
Use the Feedback screen to provide comments and information about Custom Sound Pro 
software issues to Cochlear. 

 Note: If you do not have an internet connection at the time when you are recording 
your feedback, the information can be stored as a .zip file and transferred to Cochlear via 
email, memory stick, or other method at another time. 

Task steps: 

1. Click on Help > Provide Feedback in the Menu bar. 

The Feedback window displays. 

2. Enter your name into From, a brief description of the comment or issue into Short 
Description, and a detailed description into Please provide your feedback or steps 
to reproduce the issue. 

3. Select Include an anonymous patient export file to add information about the 
current patient to the feedback report. 

4. If you do not have an internet connection, click Save to save the feedback report in 
the Cochlear Feedback Reports folder on your Desktop as a zip file. 

The zip file contains: 

• A BugReport text file containing detailed information about your computer. 

• A ClinicDetails text file containing the feedback report and information about 
the clinic and sender. 

• A .zip file containing CustomSoundLog files (.csl) which record Custom Sound 
Pro software events. 

5. If you have an internet connection, click Send to transmit the feedback report to 
Cochlear. 

A confirmation message appears. Close the screen. 

Result: 

• The feedback report is sent or saved. 
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Activate regional options 
Some features or products are only available in Custom Sound Pro software by activating a 
regional option. Regional options are activated using the Research and Regional Options 
Manager. Option information is specified in regional options files (*.cofx). 

 Note: 

• The Change Research and Regional Options menu option is greyed out and not 
available when a session is open. 

• Before activating a regional option, you need an authorisation key for the option you 
want to activate. 

Task steps: 

1. Click on Tools > Change Research and Regional Options in the Menu bar. 

The Research and Regional Options Manager wizard displays. 

2. Click the Activate options option button. 

3. Click Next. 

4. Click Browse and select the relevant regional options file (*.cofx). 

5. Click Open. 

6. Type the authorization key for the option. 

7. Click Next. 

8. Read the conditions and select the I Accept check box. 

9. Click Activate Options. 

10. Click Close to close the Research and Regional Options Manager. 

Result: 

• The selected regional option is activated. 
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Deactivate regional options 
Some features or products are only available in Custom Sound Pro software by activating a 
regional option. Once activated, these options can also be deactivated using the Research 
and Regional Options Manager. 

 Note: 

• The Change Research and Regional Options menu option is greyed out and not 
available when a session is open. 

• Before deactivating a regional option, bear in mind that you need an authorization 
key to reactivate it again. 

Task steps: 

1. Click on Tools > Change Research and Regional Options in the Menu bar. 

The Research and Regional Options Manager wizard displays. 

2. Click the Deactivate options option button. 

3. Click Next. 

4. Select the check box for the option you want to deactivate. 

5. Click Deactivate Options. 

A success message displays. 

 Note: Custom Sound Pro software must be re-started before the deactivation 
takes effect 

6. Click Close to close the Research and Regional Options Manager. 

Result: 

• The selected regional option is deactivated. 
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Reference topics 
• Cochlear Database Manager 

• MAPs 

• Adjust Manufacturer's Settings 

• Programming 

• Sound processors, devices, and accessories 

• Keyboard shortcuts 

• Status bar 

• Set Levels toolbar 

• Report Viewer 

• Device performance changes 

• Summary of safety and clinical performance 

• Serious incidents 

• Table of symbols 

• Legal statement 

Cochlear Database Manager 
A database is automatically created, or the application is configured to connect to a 
network database when Custom Sound is first installed. The database is shared across 
Custom Sound Pro software and Custom Sound EP software and contains the records for 
all patients created in either application. The Cochlear Database Manager allows you to 
manage databases and to select the database you want to connect to. 

The Cochlear Database Manager contains the following tabs: 

• Connections: displays the list of connections to existing databases. When you log on 
to Custom Sound Pro software or Custom Sound EP software, the software connects 
to the database specified by the current connection. The connection that is currently 
in use is indicated by a Check symbol . 

• Databases: displays the list of existing databases. The Databases tab allows you to 
connect to the database server, create new databases and manage existing 
databases. 
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Create or edit a connection 
The Cochlear Database Manager allows you to create a new connection to an existing 
database, and to edit or delete existing connections. 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Windows Start menu. 

3. Click Add in the Connections tab. 

The Add Connection window displays. Mandatory boxes are indicated by a Required 
symbol . 

4. Type a name for the connection in the Connection Name box. 

5. Type the name of the server on which the database resides in the Server\Instance 
Name box. 

6. If a password is required to log on to the database server, select the Use a Specific 
Username and Password option button and type the username and password in 
the appropriate boxes. 

Otherwise, retain the Use Windows Integrated Security option button. 

7. Select the database you wish to connect to from the Database drop-down list. 

8. To adjust the amount of time that Custom Sound Pro software or Custom Sound 
EP software will wait for a response from the database server, type the number of 
seconds in the Connection Timeout box. 

9. Click OK. 

10. To select the new connection as the default, right-click on the connection and select 
Set as Active Connection. 

The connection is marked with a Check symbol . 

Result: 

• The connection is added to the Connections list. 

To edit a connection, right-click on the connection and select Edit Connection. Edit the 
existing details as required, and click OK. 

To delete a connection, right-click on the connection, select Delete Connection and click 
Yes to confirm the deletion. Deleting a connection does not delete the database it 
connects to. 
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Connect to a server 
In order to create or manage databases, you must first connect to the server on which the 
databases reside. 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Cochlear folder, under the Windows 
Start menu. 

3. Click the Databases tab in the Cochlear Database Manager. 

4. Click Connect. 

The Connect window displays. 

5. Type the name of the server on which the databases reside in the Server\Instance 
Name box, or retain the default setting. 

6. Retain the Use Windows Integrated Security option button. 

Alternatively, select the Use a Specific Username and Password option button and 
type the username and password for the database server in the appropriate boxes. 

7. Click OK to save the changes and close the Connect window. 

The databases that exist on the server display in the Database list. 

Result: 

• Cochlear Database Manager is now connected to the server. 

Once the connection to the server has been established, the Cochlear Database Manager 
allows you to: 

• Create a new database 

• Upgrade a database 

• Back up or restore a database 

• Delete a database 
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Create a database 
The Cochlear Database Manager allows you to create a new database as desired. By 
default, a connection to the new database is automatically created, but is not selected as 
the default connection. 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Cochlear folder, under the Windows 
Start menu. 

3. Click Create in the Databases tab. 

The Create Database window displays. 

4. Type a name for the database in the Database box. 

5. Type the clinic and clinician names in the appropriate boxes. 

The clinician name is used to automatically create a clinician with clinic administrator 
rights in Custom Sound Pro software. 

6. Type a name for the connection in the Connection Name box. 

7. Retain the Use Windows Integrated Security option button. 

Alternatively, select the Use a Specific Username and Password option button and 
type the username and password for the database server in the appropriate boxes. 

8. Click Create. 

The database displays in the Database list, and a connection is created in the 
Connections tab. 

Result: 

• The new database is created. 

If you do not wish to automatically create a new connection when the database is created, 
clear the Create a New Connection for This Database check box. 
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Upgrade a database 
An existing database may need to be upgraded when a new version of the Custom Sound 
Pro software is released. By default, the Cochlear™ Database Manager backs up the 
existing database prior to performing the upgrade. 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Cochlear folder, under the Windows 
Start menu. 

3. Select the database in the Database list. 

4. Click Upgrade. 

5. Type a file location and filename for the backup file, or retain the default file path. 

6. Click Upgrade. 

Result: 

• The database is upgraded. 

If you do not wish to back up the database prior to upgrading, clear the Backup the 
Database Before Upgrading check box. 

 Note: When you upgrade the Custom Sound Pro software from 2.0 or later, the installer 
provides the option to upgrade the database. When the upgrade option in the installer is 
selected, the Custom Sound Pro software database that is currently in use is upgraded. 
Any additional databases or databases created using an earlier version of the software can 
be upgraded using the Cochlear Database Manager. 
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Back up or restore a database 
The Cochlear Database Manager allows you to back up a database to an external file. A 
database can be restored from a previous backup if required. 

To back up a database: 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Cochlear folder, under the Windows 
Start menu. 

3. Select the database in the Database list. 

4. Click Backup. 

Alternatively, right-click on the database and click Backup. 

5. Type a file location and filename for the backup file, or retain the default file path. 

6. Click Backup. 

Result: 

• A backup of the database is saved to the specified location. 

  

To restore a database: 

Task steps: 

1. Click Restore in the Databases tab. 

2. Type a new name for the database in the Database box. 

3. Type the file path of the file you wish to restore in the Backup File box. 

Alternatively, click Browse, navigate to the desired file, and click OK. 

4. Click Restore. 

Result: 

• The restored database displays in the Database list. 
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Delete a database 
Databases that are no longer required can be deleted from the Database list. A deleted 
database cannot be restored. A database can only be restored from a backup file, and it is 
recommended you back up the database prior to deletion. 

Task steps: 

1. Navigate to the Windows Start menu. 

2. Open the Cochlear Database Manager from the Cochlear folder, under the Windows 
Start menu. 

3. Select the database you wish to delete in the Database list. 

4. Click Delete. 

Alternatively, right-click on the database and select Delete Database. 

5. Click Yes to confirm the deletion. 

Result: 

• The selected database is no longer available. 

MAPs 
A MAP is a program that improves a cochlear implant patient's hearing experience by 
modifying the behaviour of the sound processor, which controls the electrical pulses sent 
to the cochlear implant's electrodes. 

Determine compatibility of MAPs 
The message box on the Set Levels screen may display messages regarding the 
compatibility of the MAP to other Cochlear software (Remote Assistant Fitting). 

The notification box on the Finalise screen may display messages regarding the 
compatibility of the MAP with MVBT programming with Remote Assistant Fitting. 

For the MAP to be modified by the patient using Remote Assistant Fitting, it must be within 
compliance levels. If the MAP is not compatible with other Cochlear software, updates can 
only be made using Custom Sound Pro software. 

Estimating compliance levels indicates where the MAP is not compatible with other 
Cochlear software. If modifications are made to the MAP using Remote Assistant Fitting, 
adjust the MAP parameters to allow compatibility. 
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Adjust manufacturer's settings 
Manufacturer's settings are applied by default when a MAP is created. 

 Note: These settings contain manufacturer's defaults and should only require 
adjustment in rare clinical cases. 

Task steps: 

1. Display the Acoustic, Global Adjustments, Comfort, Thresholds, or Set Levels  
screen. 

2. Click on MAP > Manufacturer's Settings (L or R) in the Menu bar. 

The Manufacturer's Settings window displays. 

3. Adjust the desired boxes. 

 Note: You will need to take your patient off air to adjust some of the 
manufacturer's settings. 

 Note: If you make a change to a parameter that automatically alters the value of 
another parameter, a notification will appear. 
For example: "The following parameters are altered by changing C-SPL (dB) • 
Loudness Growth". 

4. Click Close  to save the changes and close the Manufacturer's Settings window. 

Result: 

• The manufacturer's settings are adjusted. 
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The following parameters are available in the Manufacturer's Settings window based on 
the type of sound processor:  

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid and Freedom Sound 
Processors 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE, 
CP1000 - Nucleus 7, CP900 Series, CP800 Series, Freedom Hybrid and Freedom Sound 
Processors  

Frequency 
Table: 

The frequency table defines the frequency range (or bandwidth) that is 
assigned to each active channel in the MAP. A given channel receives 
stimulation when its bandwidth has sufficient energy in it to be selected 
as a maxima. The frequency table depends upon the sound coding 
strategy and the number of channels in the MAP. 

T-SPL (dB): Specifies the SPL for a speech signal at which T level stimulation starts 
(excluding CP802 sound processors). 

C-SPL (dB): Specifies the SPL for a speech signal at which C level stimulation starts 
(excluding CP802 sound processors). 

Loudness 
Growth: 

(previously known as Q-value) Controls the steepness of the loudness 
growth function. 

Volume 
Adjustment 
(%DR) 

Specifies the maximum percentage of the dynamic range by which C 
levels can be adjusted when modifying the volume level. 

Jitter Specifies the percentage by which the stimulation rate will be varied in a 
positive or negative direction for SPEAK MAPs (250 Hz) only.  
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Programming 
• Acoustic component 

• Legacy programming methods 

Acoustic component 
Hybrid patients use acoustic stimulation (sound processor and acoustic component) and 
electric stimulation (sound processor and cochlear implant) to access the entire sound 
spectrum. 

When creating a MAP for a Freedom Hybrid sound processor, a CP900 Series, CP1000 - 
Nucleus 7, CP1001 - Nucleus 7 SE, CP1002 - Nucleus 7 S or CP1110 - Nucleus 8 Sound 
Processor (when the acoustic component is required), the acoustic component needs to be 
programmed in addition to the electric component. Custom Sound Pro software 
automatically creates a MAP where low frequency information is presented via acoustic 
stimulation only and high frequency information is presented via modified frequency-to-
electrode allocation tables. The boundary of where acoustic stimulation stops and electric 
stimulation begins is determined by the limit of patient’s residual hearing. 

Custom Sound Pro software provides three prescriptive methods which specify the target 
gain and maximum output level for each frequency band of amplification, and can be used 
as a baseline for programming the acoustic component: 

•  NAL-RP (National Acoustic Laboratories-Revised, Profound)  

• DSL (Desired Sensation Levels)  

A choice of two fitting procedures can be used with the prescriptive methods: 

• WDRC (Wide Dynamic Range Compression): designed to amplify low-level input 
signals more than high-level input signals to provide audibility, while ensuring 
comfortable volume levels at all times. WDRC may be suitable for patients with 
loudness tolerance or loudness recruitment issues. WDRC is the default setting for 
NAL. 

• Linear: provides the same amount of amplification (gain) to all input sound levels 
until the maximum power output is achieved. Linear gain may be suitable for 
patients who do not like to hear too much background noise in quiet, or when the 
gain for soft sounds increases the potential for feedback (particularly combined with 
large vents). 
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Legacy programming methods 
At activation the primary goal is comfortable audibility; further fine tuning such as 
loudness balancing, or the perception of soft sounds can take place at a later time when 
the patient is more familiar with electric hearing. 

With audibility achieved, early focus is placed on the optimisation of hearing outcomes and 
rehabilitation to support the patient’s hearing goals. 

The guided workflows within the software support this methodology. The Set Levels screen 
can still be used for the streamlined or legacy programming methods. The streamlined 
programming methods are: 

•  Behavioural method: T levels are measured on selected channels using 
psychophysics and C levels are measured simultaneously using live voice testing. 
This method is appropriate for patients who can make reliable behavioural 
responses to sound. 

•  NRT/objective offset method: the T level profile is offset from the objective 
measurement profile and a single offset channel is measured using psychophysics. C 
levels are measured using live voice testing. This method is appropriate for patients 
who may give limited behavioural responses. 

In addition to the streamlined programming methods, individual channels can be 
measured as required. 

 Note: To pause or stop at any time while setting T and C levels, click the Stop All 

Stimulations button  on the Programming toolbar. 

 Notes: 

• Streamlined programming is only available for MAPs created using Monopolar 
stimulation modes. 

• Streamlined programming is not available for ABI541, Nucleus 24 ABI and Nucleus 22 
implant types. 
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Sound processors, devices and accessories 
• Link bilateral sound processors for smartphone use 

• Smartphone-compatible hearing devices 

Link bilateral sound processors for smartphone use 
For bilateral patients with CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE or CP1000 - Nucleus 7 Sound Processors for each implant side, the 
sound processors are linked together which means they can be paired simultaneously with 
certain smartphones: 

• iPhone, iPad or iPod touch (iOS devices) (excluding CP1002 - Nucleus 7 S Sound 
Processors) 

• Compatible smartphones with Android with the Nucleus Smart App installed 

In most cases, the sound processors for bilateral patients are linked automatically when 
you write the MAPs to the sound processors. In some cases after you write to the sound 
processor you are prompted to rewrite to the other sound processor, for example, a 
patient with an existing CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, 
CP1001 - Nucleus 7 SE or CP1000 - Nucleus 7 Sound Processor who is implanted on their 
other side and receives another CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 
S, CP1001 - Nucleus 7 SE or CP1000 - Nucleus 7 Sound Processor. 

When a patient pairs their linked sound processors to their device, the sound processors 
are recognised as a set. This means any adjustments made using the Nucleus Smart App 
or the iOS device hearing aid controls are made to both sound processors. For example, 
patients can increase the volume for both sound processors in a single operation. 
Alternatively, patients can adjust their linked sound processors individually, if preferred. If 
the programs that are written to the sound processors are different, for example, a 
different number of programs, or programs written to different slots, the patient can only 
adjust their sound processors individually. 
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Smartphone-compatible hearing devices 
CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and 
CP1000 - Nucleus 7 Sound Processors can be used with an iPhone® or smartphones with 
Android™. 

Made for iPhone hearing devices 

Made for iPhone hearing devices are sound processors or hearing aids that can be paired 
with an iPhone®, iPad® and iPod touch® (iOS devices). When paired with an iOS device, 
Made for iPhone hearing devices can be adjusted using the hearing aid controls on the iOS 
device, for example, increase the volume and change the program. Patients can also 
stream audio from their iOS device directly to their paired hearing device. CP1110 - 
Nucleus 8, CP1150 - Kanso 2, CP1001 - Nucleus 7 SE and CP1000 - Nucleus 7 Sound 
Processors are Made for iPhone hearing devices. 

Patients with CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1001 - Nucleus 7 SE or CP1000 - 
Nucleus 7 Sound Processors can also adjust their sound processor, for example, change 
the program, using the Nucleus Smart App. The Nucleus Smart App is an alternative to 
using a remote control to adjust a sound processor. 

Smartphones with Android 

Patients can use the Nucleus Smart App for smartphones with Android to adjust their 
CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE or 
CP1000 - Nucleus 7 Sound Processors, for example, change the program, and view details 
of the sound processor such as battery status. The Nucleus Smart App is an alternative to 
using a remote control to adjust a sound processor. 

CP1110 - Nucleus 8, CP1150 - Kanso 2, CP1002 - Nucleus 7 S, CP1001 - Nucleus 7 SE and 
CP1000 - Nucleus 7 Sound Processors support streaming audio directly from compatible 
Android handsets without the need for a phone clip or other accessory. 
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Keyboard shortcuts 
Keyboard shortcuts provide you with a quick way of accessing Custom Sound Pro software 
functions. Some are generally available, while others apply only to the Set Levels screen. 

Shortcuts 

  Shortcut Action 

Stimulation 

  ESC Stop stimulation 

Online Help 

  F1 Access the Help file 

Sound processor 

  F3 Connect / disconnect a sound processor. 

Patient 

  F4 Enable talk over mode 

  F5 Go Live 

Tools 

  F6 Enable / disable Programming Pod communication 

  F9 Access the Preferences window 

MAPs 

  Ctrl + Z Undo. 

  Ctrl + Y Redo. 

  Ctrl + S Save the currently selected MAP 

  Shift + Ctrl + S Save all open MAPs 

  Ctrl + F4 Close the currently selected MAP 

  Shift + Ctrl + F4 Close all open MAPs 

  Ctrl + M Open MAP Title and Notes 

Channels 

   
 / Ctrl +  

Moves to next left measurable channel if an 
individual channel is selected. Moves to next left 
band if a band is selected. 

   
 / Ctrl +  

Moves to next right measurable channel if an 
individual channel is selected. Moves to next right 
band if band is selected. 
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Global Adjustments 

  T Switch to T mode (all keyboard actions will be 
performed on T levels). 

  C Switch to C mode (all keyboard actions will be 
performed on C levels). 

  B Switch to T & C mode (all keyboard actions will be 
performed on both T & C levels). 

Thresholds 

  G n Produce n stimuli on the focused channel. 

  S n Enter Set the number of stimuli to n. 

Global Adjustments, Comfort, and Thresholds 

  U In Global or Comfort, moves focus to the Step size 
box. In Thresholds, moves focus to the Up Step box. 

  D In Global or Comfort, moves focus to the Step size 
box. In Thresholds, moves focus to the Down Step 
box. 

   
 / Ctrl +  

Increase the T and / or C level or objective 
measurement level by the up step size. 

   
 / Ctrl +  

Decrease the T and / or C level or objective 
measurement level by the down step size. 

  J Produce the set number of beeps at T or C level on 
the focused channel in Comfort or Thresholds. 

  Z Toggle between automatic stimulation on and off. 

  Tab Cycles through selectors.  

In Global: Master Volume, Bass, Treble. In Comfort: 
Band A to Band H. In Thresholds: Very High to Very 
Low. 

Sweep levels 

  R Sweep right (ascending frequency) 

  L Sweep left (descending frequency) 

  
 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 163 

Set Levels screen shortcuts 

  Shortcut Action 

Select channels in the Channel Grid 

   Move the channel focus to the next left measurable 
channel. 

   Move the channel focus to the next right measurable 
channel. 

  Ctrl +  Move the channel focus to the next left channel. 

  Ctrl +  Move the channel focus to the next right channel. 

  V Toggle between select and deselect a channel. 

  X Toggle between activate and deactivate a channel. 

  I Toggle between measure and interpolate a channel. 

  Ctrl + D Toggle between double and unlink a channel. 

Select mode for measuring T, C and objective measurement levels 

  T Switch to T mode (all keyboard actions will be 
performed on T levels). 

  C Switch to C mode (all keyboard actions will be 
performed on C levels). 

  O Switch to O mode (all keyboard actions will be 
performed on objective measurement levels). 

  B Switch to T & C mode (all keyboard actions will be 
performed on both T and C levels). 

  M Toggle between T, C and T & C modes. 

Measure T, C and objective measurement levels (depending on selected mode) 

  n Enter Set the T and / or C level to n. 

  U n Enter Set the up step size to n. 

  D n Enter Set the down step size to n. 

   Increase the T and / or C level or objective 
measurement level by the up step size. 

   Decrease the T and / or C level or objective 
measurement level by the down step size. 

  Page Up n Increase the T and / or C level by n. 

  Page Down n Decrease the T and / or C level by n. 

  Z Toggle between automatic stimulation on and off. 

  S n Enter Set the number of stimuli to n. 
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  F2 Produce one stimulus at T or C level on the focused 
channel. 

  G n Produce n stimuli at T or C level on the focused 
channel. 

  J Produce the set number of stimuli at T or C level on 
the focused channel. 

Sweep levels (depending on selected mode) 

  R Sweep right (ascending frequency) for the set 
number of channels. 

  Ctrl + R n Enter Sweep right (ascending frequency) for n channels. 

  L Sweep left (descending frequency) for the set 
number of channels. 

  Ctrl + L n Enter Sweep left (descending frequency) for n channels. 

  N n Enter Set the number of channels to be stimulated to n. 

  N S Enter Set the number of channels to be stimulated to 
selected. 

  N A Enter Set the number of channels to be stimulated to all. 

  P n Enter Set the percentage of the dynamic range to n. 

Shift levels (depending on selected mode) 

  Ctrl +  Increase global T and / or C levels. 

  Ctrl +  Decrease global T and / or C levels. 

   Increase global C levels in live. 

   Decrease global C levels in live. 

  H P Enter Set the shift mode to percentage of the dynamic 
range. 

  H C Enter Set the shift mode to current level. 

  A A Enter Set the channel selection to all. 

  A S Enter Set the channel selection to selected. 

  Q n Enter Set the shift step size to n. 

Tilt levels (depending on selected mode) 

  [ Left tilt global T and / or C levels. 

  ] Right tilt global T and / or C levels. 

  F n Enter Set the tilt value to n. 
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Use the Data Grid 

  Shift +  
 / Shift +  

Move up / down one row in the Data Grid. 

  Shift +  
/ Shift +  

Move left / right one column in the Data Grid. 

   
 /  

Select a value from the drop-down list in the selected 
cell (Active Electrode, Stimulation Mode / Indifferent 
Electrode, Gain and Pulse Width fields only). 
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Status bar 
The status bar provides information on the current status of the patient, the connected 
sound processor and programming interface, and the implant. The status bar is colour 
coded to differentiate between right ear (red) and left ear (blue) implants and sound 
processors. 

Right side Left side 

  
The following icons may display on the status bar: 

  Tooltip or message Status 

Auto stimulate status 

 Auto stimulate Automatic stimulation is currently enabled when 
setting T and C levels. 

Programming interface status 

 
(Programming interface, 
com #) 

The specified programming interface is connected. 

 
(Wireless Programming 
Pod, com #) 

Fully charged. 

 
  Not fully charged. 

 
  Low on charge. Please recharge or replace the 

battery. 

 
  No charge. Please recharge or replace the battery. 

 
  Battery state is unknown. 

 
(Remote assistant type) The specified remote assistant is connected. The 

right-click menu allows you to: 

• Upgrade the software for the remote assistant. 

• Export the patient's AutoNRT and impedance 
data. 

 
Updating device software The remote assistant software is being updated. 
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  Tooltip or message Status 

Sound processor status 

 
(Sound processor type, 
serial number) 

The specified sound processor is connected. The 
right-click menu allows you to connect or reset a 
sound processor. 

 Note: The sound processor icon varies according to 
the sound processor that is connected. 

 
(Sound processor type, 
serial number) 

The specified sound processor is using a Nucleus 22 
coil, and is configured for Nucleus 22 use only. 

 Note: The sound processor icon varies according to 
the sound processor that is connected. 

 
No processor connected No sound processor is connected. 

 
Writing… Programs are being written to the connected sound 

processor. 

 
  Compliance levels are being estimated for the 

connected sound processor. 

 
  A reset of the sound processor is required. 

 
Getting battery 
suitability… 

Battery suitability is being checked for the connected 
sound processor. 

 
Battery Health The battery for the CP1150 - Kanso 2 Sound Processor 

cannot be charged and needs to be replaced. 

 
Implant ID enabled for 
MAPs on this processor 

Implant ID is enabled for the connected sound 
processor. 
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  Tooltip or message Status 

Program status 

 

 

(MAP title, environment, 
volume and sensitivity 
settings) 

The programming slot on the connected sound 
processor contains the specified program. The right-
click menu allows you to open the MAP, go live with 
the program, or erase the program from the 
programming slot. 

A red dot displayed on the icon indicates the presence 
of MAPs that have been modified using Remote 
Assistant Fitting. 

 
  The programming slot on the connected sound 

processor is empty. 

 
Corrupt MAP in slot The MAP in the programming slot is corrupt. 

 
  The MAP in the programming slot is not in the 

database. 

 

  The specified program is currently in live mode. 

Implant status (excluding Nucleus 22 implants) 

 
Implant detected Communication with the implant has been 

established. 

 
No communication with 
implant 

Communication with the implant cannot be 
established. This may indicate the coil has come off 
the patient's implant or cables are disconnected or 
faulty. 

 
Incorrect implant type 
detected 

The selected sound processor belongs to a different 
implant type. 

 
Telemetry being affected 
by other processors 

Telemetry is being affected by another sound 
processor in too close proximity. For bilateral 
patients, the sound processor for the contralateral 
ear may need to be switched off. 

 
Could not read implant ID. 
Please remove coil from 
implant, wait 5 seconds 
then reconnect coil. 

The implant ID could not be read during the implant 
ID check. 



  

© Cochlear Limited 2024 Custom Sound Pro software User Guide – 169 

  Tooltip or message Status 

Patient status 

 
Patient (name surname) is 
not currently open 

The patient of the connected sound processor is in 
the database. Click to start a programming session. 

 
Patient of this processor is 
unknown. Click to register 

The patient of the connected sound processor is not 
in the database. The Unknown Patient prompt 
displays automatically and allows you to register the 
patient or reset the sound processor. If a session is 
currently open, you can also associate the programs 
on the sound processor with the open patient. 

 
Patient (name surname) The patient of the connected sound processor is in 

the database, and a programming session is open. 

 
Patient (name surname) is 
not currently open 

The patient of the connected sound processor differs 
to the currently open programming session. Click to 
start a programming session for the connected 
patient. 

 
Patient (name surname) is 
archived 

The patient of the connected sound processor is 
archived in the database. Click to make the patient 
active. 
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Set Levels toolbar 
The Set Levels toolbar is available on the Set Levels screen only. 

Set Levels toolbar 

 
Save MAP Save the currently selected MAP. 

 
MAP Parameters Access the MAP Parameters window to set MAP 

parameters. 

 
Acoustic Access the Acoustic window to prescribe acoustic 

levels (Freedom Hybrid and CP900 Series, CP1000 - 
Nucleus 7, CP1001 - Nucleus 7 SE, CP1002 - Nucleus 7 
S and CP1110 - Nucleus 8 Sound Processors only). 

 
Undo Undo the previous action, up to a maximum of 20 

actions. Previous actions can be selected from the 
drop-down list. 

 
Redo Redo the previous action, up to a maximum of 20 

actions. Previous actions can be selected from the 
drop-down list. 

 
Go Live Measure T and C levels using live voice testing. 

 
Stop All Stimulations Stop all current stimulations. 

 
Hug T Profile Set C levels to follow the T level profile with a dynamic 

range of 2. 

 
Predict Levels Predict T and C levels when creating a new MAP from 

an existing MAP using a different stimulation rate or 
pulse width. 

 
Make All Channels 
Measurable 

Enable T and C levels to be measured on all channels. 

 
Make Only Selected 
Channels Measurable 

Enable T and C levels to be measured on the selected 
channels only. The levels on the non-selected 
channels are automatically interpolated. 

 
Reverse Electrode Order Reverse the tonotopic order of channels by changing 

the channel-to-electrode configuration for all 
channels (ABI541 and Nucleus 24 ABI implants only). 

 
Title/ Notes Access the Title and Notes window to enter a title 

and/or Notes. 

 
Modify Gains Access the Gain Shapers window to adjust high 

and/or low frequency gains. 
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Configure Live Program 
Settings 

Access the Live Program Settings window to adjust 
the volume, sensitivity and environment settings that 
apply when going live. 

 
Create Progressive MAPs Create additional MAPs from an initial MAP, with the C 

levels adjusted on each progressive MAP. 

 
MAP Report Access the Report viewer to print the MAP details 

(saved MAPs only). 

 
Estimate Compliance 
Levels 

Estimate the maximum C level achievable for each 
channel in a MAP. 

 
Measure Skin Flap and 
Optimise Power Level 

Estimate the skin flap thickness and optimise the 
power level for the MAP (Freedom and CP900 Series 
Sound Processors with Nucleus 22 implants only). 

 
Close MAP Close the currently selected MAP. 
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Report Viewer 
The Report Viewer provides a common way to view all of the reports generated 
throughout Custom Sound Pro software. You can use it to zoom the report view in or out, 
specify the page setup (size, orientation, margins, font, headers and footers), preview for 
printing, and to print the report. 

Custom Sound Pro software reports include: 

• Session Details report 

• Patient Take Home report 

• MAP report 

• MAP upgrade/conversion report 

• MAP comparison report 

• Program comparison report 

• Historical session and patient take home reports 

Custom Sound Pro software performance changes 
If the Custom Sound Pro software has unexpected performance changes, for example, 
closing unexpectedly, becoming non-responsive or responding slowly, Cochlear suggests 
that you follow recommendation below: 

• Make sure the database connection is active. 

• Disconnect and reconnect processor and any programming pods if there are 
connection issues. 

• Check the computer with the Custom Sound Pro software meets the recommended 
system specifications. 

• Use the recommended screen resolution. 

• If the Custom Sound Pro software becomes unresponsive, wait for a few minutes or 
end the Custom Sound process via the Windows Task Manager. 

• Close other applications or restart the computer to free system resources. 

Please contact your Cochlear representative for further support if you continue to have 
problems. 
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Serious incidents 
Whilst serious incidents in relation to medical devices are rare, it is acknowledged that 
incidents may happen. As an organisation, Cochlear recognises the potential for harm and 
will respond to any reported serious incident. 

What is a serious incident? 
A ‘serious incident’ means any event that directly or indirectly has caused or could have 
caused an unexpected or unwanted event including any of the following: 

• The death of a patient, user or other person, 

• The temporary or permanent serious deterioration of a patient’s, user’s or other 
person’s state of health, 

• A serious public health threat. 

Reporting a serious incident 
There is no definitive list of events/incidents that constitute a serious incident, however all 
serious incidents should be reported to: 

• your local Cochlear office 

www.cochlear.com/intl/contact/global-offices 

People within the European Union should also report all serious incidents to: 

• your National Competent Authority 

http://ec.europa.eu/growth/sectors/medical-devices/contacts_en 

People within Australia should also report all serious incidents to: 

• Therapeutic Goods Administration 

https://www.tga.gov.au 

Summary of safety and clinical performance 
For people in the European Union, a summary of the safety and clinical performance of the 
Custom Sound Pro software can be found at: 

https://ec.europa.eu/tools/eudamed. 
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Table of symbols 
Symbol Description 

 
Manufacturer. 

 
Date of manufacture. 

 
Authorised representative in the European Community. 

 
 www.cochlear.com/manuals 

 Follow instructions for use on this website.  

 Specific warnings or precautions associated with the 
device, which are not otherwise found on the label. 

 CE registration mark with notified body number. 

 Medical Device. 

 Unique Device Identifier. 

Legal statement 
The statements made in this Custom Sound Pro software User Guide are believed to be 
true and correct as of the date of publication. However, specifications are subject to 
change without notice. 

Copyright 2024 Cochlear Ltd. All rights reserved. 
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ACE, Advance Off-Stylet, AOS, Ardium, AutoNRT, Autosensitivity, Baha, Baha SoftWear, BCDrive, Beam, Bring 
Back the Beat, Button, Carina, Cochlear, 科利耳, コクレア, 코클리어, Cochlear SoftWear, Contour, コントゥア, 
Contour Advance, Custom Sound, DermaLock, Freedom, Hear now. And always, Hugfit, Human Design, Hybrid, 
Invisible Hearing, Kanso, LowPro, MET, MP3000, myCochlear, mySmartSound, NRT, Nucleus, Osia, Outcome 
Focused Fitting, Off-Stylet, Piezo Power, Profile, Slimline, SmartSound, Softip, SoundArc, SoundBand,  
True Wireless, the elliptical logo, Vistafix, Whisper, WindShield and Xidium are either trademarks or registered 
trademarks of the Cochlear group of companies. 

ADRO is a registered trademark of Cirrus Logic International (UK) Ltd. Intel and Pentium are registered 
trademarks of Intel Corporation. Microsoft, Active Directory, SQL Server and Windows and are trademarks of 
the Microsoft group of companies. iPhone, iPad and iPod touch are trademarks of Apple Inc., registered in the 
U.S. and other countries. The Bluetooth word mark and logos are registered trademarks owned by Bluetooth 
SIG, Inc. and any use of such marks by Cochlear Limited is under license. 
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